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Prólogo 
 
 
Este manual ha sido creado por Hologic®, Inc. Tiene el objetivo de guiar al usuario avanzado durante la configuración, la 
instalación y el uso del hardware Faxitron Core, así como del sistema de software Vision, ambos desarrollados por Hologic, Inc. 
 
El usuario deberá configurar primero el hardware y, a continuación, iniciar el software Vision. Antes de continuar, revise los 
procedimientos de configuración obligatorios incluidos en la sección 4 de este manual. 
 
 
 
 
 
Indicaciones de uso 
 
El sistema de radiografía digital de especímenes (DSR) Faxitron Core es un sistema de obtención de imágenes digitales  
de rayos X que está alojado en una cabina y está destinado a generar y controlar rayos X para examinar varias regiones 
anatómicas, así como para verificar rápidamente que se haya extirpado el tejido correcto durante la biopsia percutánea. 
Realizar directamente la verificación en la misma sala de biopsias permite que los casos se concluyan más rápidamente, 
limitando así el tiempo necesario para explorar al paciente. La radiografía de los especímenes puede limitar potencialmente  
el número de citas para los pacientes. Este dispositivo está destinado a utilizarse en todos aquellos lugares que los 
profesionales médicos consideren pertinentes, como áreas quirúrgicas o estancias adyacentes a las áreas quirúrgicas.  
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Este manual ha sido creado por Hologic, Inc. Tiene el objetivo de guiar al usuario durante la 
configuración, la instalación y el uso del hardware Faxitron Core, así como del software Vision, 
ambos desarrollados por Hologic, Inc. 
 
El usuario deberá configurar primero el hardware y, a continuación, iniciar el software Vision. 
Antes de intentar utilizar el sistema, repase en este manual, como mínimo, los procedimientos 
de configuración y seguridad obligatorios. 
 
Gracias de parte de todos los que integramos Hologic, Inc. 
 
Fabricante e información de contacto 
 

 
 
 

Hologic, Inc. 
36 Apple Ridge Road 
Danbury, CT 06810 EE. UU. 
1.800.447.1856 
www.hologic.com 
 

 
PROMOTOR DE AUSTRALIA 
Hologic (Australia and New Zealand) Pty Ltd 
Suite 302, Level 3 
2 Lyon Park Road 
Macquarie Park NSW 2113 
Tel.: 02 9888 8000 
 

 
 

Hologic, BV 
Da Vincilaan 5 
1930 Zaventem 
Bélgica 
Tel.: +32 2 711 46 80 
Fax: +32 2 725 20 87 
 

 

 

 1.0.0 
Introducción 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
En este manual y en el sistema de ayuda en línea, se utilizan los siguientes símbolos: 
 
 
Advierte al lector de una posible electrocución en caso de que ignore la 
advertencia y utilice deliberadamente herramientas específicas para abrir una 
cabina eléctrica precintada y manipular su contenido.  Nota: Hologic, Inc. no 
proporciona ninguna herramienta. 
 
 
Advierte al lector de una situación de peligro. Por lo general, este símbolo va 
acompañado de un símbolo más específico y de las instrucciones pertinentes en 
cuanto a la naturaleza del peligro, el resultado esperado del peligro y la 
información para evitarlo. 
 
 
Advierte al lector de que debe tener cuidado al levantar equipos pesados para 
evitar generar lesiones corporales y daños al equipo. 
 
 
Advierte al lector de que en el área etiquetada se emite una radiación ionizada 
cuando el haz de rayos X está bajo tensión. El sistema Faxitron Core dispone de 
enclavamientos de seguridad que evitan que se acceda a la zona etiquetada 
mientras el haz de rayos X está bajo tensión. 
 
 
Advierte al lector que utilice la protección adecuada (como guantes quirúrgicos o 
un recipiente autorizado para especímenes) con el fin de evitar la exposición a 
materiales potencialmente infecciosos, como las muestras de tejidos del paciente. 

  
1.1.0 
Símbolos 
de advertencia 
y precaución 
incluidos en  
este manual 

http://www.hologic.com/
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Símbolo Descripción Estándar 

 

Para desecharlos, 
separe los dispositivos 
eléctricos y 
electrónicos de los 
desechos normales. 
Envíe el material 
desmantelado a 
Hologic o contacte con 
su representante de 
atención al cliente. 

Directiva RAEE 
2012/19/UE 

 

Fabricante ISO 15223-1, 
Referencia 5.1.1 

 

Fecha de fabricación ISO 15223-1, 
Referencia 5.1.3 

 

Radiación ionizada 
emitida al energizar 
un haz de rayos X 

ISO 7010, 
Referencia W003 

 

Advertencia para 
utilizar la protección 
adecuada 

ISO 7010, 
Referencia W009 

 

Advertencia sobre 
electricidad 

IEC 60417, 
Referencia 6042 

 

Advertencia ISO 7010, 
Referencia W001 

   

Consulte las 
instrucciones de uso 

ISO 15223-1, 
Referencia 5.4.3 

 

Siga las instrucciones 
de uso 

IEC 60601-1, Referencia 
n.º Tabla D.2, Señal de 
seguridad 10  
(ISO 7010-M002) 

 

Este sistema transmite 
energía de 
radiofrecuencia (RF) 
(radiación 
electromagnética no 
ionizante) 

IEC 60417, 
Referencia 5140 
 

 1.1.1 
Símbolos 
de advertencia 
y precaución 
incluidos en 
la etiqueta 
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Símbolo Descripción Estándar 

 

Representante 
autorizado en la 
Comunidad Europea 

ISO 15223-1, 
Referencia 5.1.2 

 
Producto sanitario ISO 15223-1, 

Referencia 5.7.7 

 
Número de catálogo ISO 15223-1, 

Referencia 5.1.6 

 
Número de serie ISO 15223-1, 

Referencia 5.1.7 

 

País de fabricación ISO 15223-1, 
Referencia 5.1.11 

 
Traducciones  
en la caja 

Hologic 

 

Precaución ISO 15223-1, 
Referencia 5.4.4 

 

Límite de humedad ISO 15223-1, 
Referencia 5.3.8 

 
 

Certificación ETL Consejo de 
Normalización de 
Canadá (SCC) y 
Administración 
de Seguridad y Salud 
Laboral de EE. UU. 
(OSHA) 

 

Solo para uso con 
prescripción médica 

FDA 21 CFR 801.109 

 
Corriente alterna IEC 60417, 

Referencia 5032 

 

Marca CE  
Conformidad europea 

Reglamento MDR (UE) 
2017/745 

 

Bus serie universal 
(USB), puerto/conector 

ISO 7000-3650 
 

 

Precaución: radiación 
(se producen rayos X) 

Hologic 
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Símbolo Descripción Estándar 

 
Fusible IEC 60417, 

Referencia 5016 

 

Advertencia; haz láser ISO 7010, 
Referencia W004  

 

Tierra IEC 60417-5017 

 

Cuidado al levantar 
objetos pesados 

Hologic 

 

Nota Hologic 

 

 



 

MANUAL DE USUARIO DE FAXITRON CORE | HOLOGIC | REVISIÓN 001 
 

Faxitron® Core 
Sistema de radiografía de muestras 
 

2 

SECCIÓN 2 
Protección radiológica 

y rayos X 
 
 
 
 
 
 
 
 
 
 

  



 
 

MANUAL DE USUARIO DE FAXITRON CORE | HOLOGIC | REVISIÓN 001 
 

SECCIÓN 
Protección 
radiológica y 
rayos X 2 

2 - 2 

Faxitron® Core 
Sistema de radiografía de muestras 
 

La radiación es energía en forma de ondas o partículas. La radiación de alta frecuencia y alta 
energía, que tiene suficiente energía para desplazar un electrón de su órbita alrededor de un 
núcleo, se denomina radiación ionizante. Los rayos X, los rayos gamma, las partículas beta, 
las partículas alfa y los neutrones son todas formas de radiación ionizante y pueden ser 
emitidos por material radioactivo, estrellas y equipos de alto voltaje. 

No podemos ver, sentir, saborear, oler ni oír la radiación ionizante, por lo que para detectarla, 
es necesario tener un equipo de vigilancia. 

Rayos X 

Los rayos X son radiaciones de alta frecuencia y alta energía que tienen suficiente energía para 
desplazar a un electrón de su órbita alrededor de un núcleo y se denominan radiaciones 
«ionizantes». Los rayos X son capaces de viajar largas distancias atravesando el aire y la 
mayoría de los demás materiales. La cantidad de energía transportada por la radiación es 
directamente proporcional a la frecuencia e inversamente proporcional a la longitud de onda. 
Los rayos X tienen una longitud de onda relativamente corta, así como alta frecuencia, por lo 
que poseen una gran cantidad de energía. 

Los rayos X pueden producir cambios biológicos en el tejido, que pueden ser beneficiosos 
cuando se utilizan en radioterapia. Sin embargo, los rayos X también pueden ser nocivos para 
los organismos biológicos, debido a su capacidad para dañar los cromosomas. 

En los centros médicos, las fuentes de radiación de rayos X incluyen: 

Máquinas de rayos X. Las máquinas de rayos X se utilizan con fines terapéuticos (radioterapia) 
y diagnósticos. Las máquinas diagnósticas de rayos X se utilizan para radiografiar varias partes 
anatómicas (tórax, piernas, senos, etc.), con fines diagnósticos. Hoy en día, solamente en los 
Estados Unidos, la radiología diagnóstica representa dos tercios de la cantidad de sus recursos 
artificiales. Las máquinas de rayos X pueden producir altos niveles de radiación ionizante. 

Máquinas de rayos X de cabina. Las máquinas de rayos X de cabina son compartimentos de 
irradiación que están encapsulados, protegidos y asegurados con enclavamientos. La máquina 
solamente puede funcionar cuando la puerta del compartimento está bien cerrada. Las tasas de 
exposición en cada lugar del exterior cumplen la tasa especificada para las áreas no controladas. 

Fuentes de radiación 
Todos estamos expuestos diariamente a la radiación. Según la Comisión Nacional de 
Protección Radiológica (NCRP, National Council on Radiation Protection), la dosis media de 
fondo en los Estados Unidos es de 360 mrem/año (3,6 mSv/año). Estas exposiciones 
provienen en su mayoría de fuentes naturales de radiación, como el radón, la radiación cósmica 
y los depósitos naturales terrestres. ¡Incluso nuestros cuerpos contienen radiactividad natural! 

Existen 2 fuentes de radiación: natural y artificial. 

Las fuentes naturales de radiación incluyen los rayos cósmicos, los rayos gamma terrestres, los 
radionúclidos del cuerpo, así como el radón y sus productos de descomposición. Se estima que la 
dosis efectiva anual media mundial procedente de fuentes naturales es de 2,4 mSv (240 mrem). 
Hay factores que afectan a las dosis efectivas de estas fuentes naturales de radiación: la tasa de 
dosis de rayos cósmicos depende de la altura sobre el nivel del mar y la latitud; la tasa de dosis de 
rayos gamma terrestres depende de la geología local; y la dosis de productos de descomposición 
del radón depende de la geología local, así como de la construcción y el uso de las viviendas. 
Consulte en la tabla 1 las dosis efectivas anuales de estas fuentes naturales. 

Tabla 1 
Dosis efectiva anual a adultos, procedente de fuentes naturales 

Fuente de exposición Dosis efectiva anual (mSv) 
Típica Elevada * 

Rayos cósmicos 
Rayos gamma terrestres 
Radionúclidos del cuerpo (excepto el radón) 
Radón y sus productos de descomposición 

0,39 
0,46 
0,23 
1,3 

2,0 
4,3 
0,6 
10 

TOTAL (redondeado) 2,4 - 
*Los valores elevados son representativos de las grandes regiones. Incluso los valores más 
altos se producen a nivel local. 
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Los rayos X médicos son una fuente importante de radiación artificial. Los rayos X médicos 
utilizan radiación ionizante tanto para el diagnóstico como para el tratamiento de lesiones y 
enfermedades. UNSCEAR (Comité Científico de las Naciones Unidas para el Estudio de los 
Efectos de la Radiación Atómica) estima que la exposición individual a la radiación médica 
oscila entre 0,4 y 1 mSv al año. La exposición a la radiación médica excede a la de todas las 
demás fuentes artificiales, pero representa menos de la mitad de la exposición a la radiación 
natural de fondo.  

Las dosis de radiación ionizante utilizadas en los rayos X de diagnóstico suelen ser bastante 
bajas, ≤50 keV. 

 
La siguiente tabla muestra las contribuciones procedentes de varias fuentes de radiación. 

 
 
 
 
Al provocar cambios en los átomos y las moléculas, la exposición a las radiaciones ionizantes 
puede tener efectos nocivos para la salud. Cuando la radiación ionizante atraviesa el tejido, se 
transfieren grandes cantidades de energía a moléculas individuales. Esta transferencia de 
energía hace que los electrones se desprendan de los átomos, y que se inicie una serie de 
efectos químicos y físicos. El más crítico de estos efectos es el daño a las moléculas de ADN. 
El cuerpo tiene mecanismos que normalmente reparan este daño, pero es posible que no se 
reparen daños extensos o de determinado tipo. Cuando el cuerpo es incapaz de reparar el 
daño, la célula puede morir o mutar. Las células mutadas tienen el potencial de convertirse en 
cánceres. La extensión del daño es proporcional a la energía transmitida o a la dosis de 
radiación ionizante recibida.  

Los efectos de la exposición a la radiación de rayos X sobre la salud se presentan en dos tipos 
generales: directos o indirectos. Se cree que los rayos X crean radicales en las células 
expuestas del cuerpo, que pueden romper o modificar los enlaces químicos dentro de las 
moléculas biológicas críticas. 

 2.2.0 Cont. 
 
 
 
 
 
 
 
 
 
 
Figura 2.2.1  
Fuentes de la dosis  
de radiación en los  
Estados Unidos. 
 
De NCRP 160, Fig. 1.1. 
Contribución porcentual de 
diversas fuentes de exposición  
a la dosis efectiva colectiva total 
(1 870 000 personas-Sv) y a la 
dosis efectiva total por individuo 
en la población de los Estados 
Unidos. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.3.0 
Efectos biológicos  
de la radiación 
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Como resultado  

(1) las células pueden lesionarse o dañarse, aunque muchas células se reparan por sí 
mismas, lo que no genera ningún daño residual;  

(2) las células pueden morir, lo que hacen millones de células del cuerpo cada día, y son 
reemplazadas durante un proceso biológico normal;  

(3) o las células pueden repararse incorrectamente y provocar un cambio biofísico. Para 
terminar, los rayos X pueden atravesar el cuerpo sin ninguna interacción. 

 
El daño provocado a las células por la radiación ionizante puede generar: 

• La producción de radicales libres 
• La rotura de los enlaces químicos 
• La producción de nuevos enlaces químicos y la reticulación entre macromoléculas 
• Daños a las moléculas que regulan los procesos celulares vitales (por ejemplo, ADN, ARN, 

proteínas) 
 
La tasa de la dosis, la dosis total recibida, la energía de la radiación, el área anatómica 
expuesta, la sensibilidad del individuo y la sensibilidad celular son todos factores que 
determinan los efectos biológicos de la exposición a la radiación. 

Existen dos tipos de efectos de la exposición a la radiación ionizante: efectos determinísticos 
y efectos estocásticos. 

 

 

 

EFECTOS DETERMINÍSTICOS Y ESTOCÁSTICOS 
Los efectos biológicos potenciales dependen de la cantidad y la rapidez con la que se reciba 
una dosis de radiación. Las dosis de radiación se pueden agrupar en dos categorías: dosis 
agudas y dosis crónicas. 

Dosis aguda y efectos determinísticos 

La exposición aguda a la radiación es una dosis alta de radiación que tiene lugar durante un 
período corto de tiempo, normalmente de segundos a días. Los efectos causados por las dosis 
agudas de radiación se denominan determinísticos; la gravedad del efecto está determinada 
por la cantidad de dosis recibida. Los efectos determinísticos suelen tener algún nivel de 
umbral, por debajo del cual es probable que el efecto no se produzca, pero por encima del cual 
se espera que se produzca. Por encima del umbral, la gravedad del efecto aumenta a medida 
que aumenta la dosis. 

Por ejemplo, una dosis en todo el cuerpo de aproximadamente 300 rems (3 Sv), 60 veces el 
límite de la dosis profesional anual, si se recibe dentro de un período de tiempo corto (por 
ejemplo, unas pocas horas) causará vómitos y diarrea a las pocas horas; pérdida de cabello, 
fiebre y pérdida de peso a las pocas semanas; y alrededor de un 50 por ciento de 
probabilidades de muerte sin tratamiento médico. Estos efectos no se producirían si la dosis 
de 300 rems (3 Sv) se acumulara gradualmente durante muchos años. 

También existe una diferencia entre las exposiciones anatómicas totales y parciales. Cuando 
una dosis aguda de 600 rem (6 Sv) en la mano causara enrojecimiento de la piel, la 
recuperación se produciría en los meses siguientes y no se esperaría ningún daño a largo 
plazo. Sin embargo, una dosis aguda de esa magnitud en todo el cuerpo podría causar la 
muerte en poco tiempo sin tratamiento médico. 

La utilización de mecanismos adecuados de protección radiológica y de límites de dosis de 
exposición profesional reducen la probabilidad de que se produzcan estos efectos. 

Los límites de dosis profesionales están muy por debajo de los umbrales de los efectos 
determinísticos. 

 2.3.0 Cont. 
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Dosis crónica y efectos estocásticos 

Una dosis crónica es una cantidad relativamente pequeña de radiación recibida durante un 
período de tiempo prolongado (por ejemplo, años). El cuerpo está mejor equipado para tolerar 
una dosis crónica que una dosis aguda, ya que tiene tiempo para reparar el daño porque, en 
un momento dado, un porcentaje más pequeño de las células necesita reparación. El cuerpo 
también tiene tiempo para sustituir las células muertas o que no funcionan por células nuevas 
y sanas. Sin embargo, esto no significa que no haya ningún riesgo relacionado con la 
exposición crónica a la radiación. 

El término estocástico significa «aleatorio», con la implicación de que no es seguro que los bajos 
niveles de exposición a la radiación produzcan un efecto. Estos niveles bajos, por debajo del 
umbral de los efectos determinísticos, pueden o no generar efectos perjudiciales para el cuerpo. 

Sin embargo, tenga en cuenta que:  

1) No existe un umbral de exposición a la radiación por debajo del cual podamos decir con 
certeza que los efectos no se producirán. 

2) Duplicar la dosis de radiación duplica la probabilidad de que se produzcan los efectos.  

La exposición crónica puede producir efectos que solamente pueden ser observados cierto 
tiempo después de la exposición inicial. Estos pueden incluir efectos genéticos y otros efectos, 
como cáncer, lesiones precancerosas, tumores benignos, cataratas, cambios en la piel y defectos 
congénitos. Generalmente, la mayor preocupación es el desarrollo de algún tipo de cáncer. 

No se observan efectos inmediatos por debajo de las dosis de 25 rem (0,25 siéverts). Los 
efectos latentes pueden aparecer años después de recibir una dosis. Mediante estudios 
realizados en poblaciones expuestas a la radiación ionizante (>0,5 Sv) se ha encontrado que 
la probabilidad de que se presente un cáncer mortal por exposición a la radiación es del 5 por 
ciento por Sv aproximadamente. 

 

 

RADIOSENSIBILIDAD 

La radiosensibilidad es la probabilidad de que una célula, tejido u órgano sufra un efecto por 
unidad de dosis de radiación. La radiosensibilidad es más alta en las células que se dividen 
rápidamente (altamente mitóticas) o que relativamente no están especializadas 
(indiferenciadas). Por esta razón, la epidermis basal, la médula ósea, el timo, las gónadas y las 
células del cristalino son altamente sensibles a la radiación. Los tejidos musculares, óseos y 
del sistema nervioso tienen una radiosensibilidad relativamente baja. Además, la 
radiosensibilidad es mayor durante la etapa fetal y se reduce progresivamente a lo largo de la 
adolescencia y la edad adulta. 

Ley básica de la radiobiología: los efectos biológicos son directamente proporcionales al índice 
mitótico y al futuro mitótico de la célula expuesta, e inversamente proporcionales al grado de 
diferenciación. La mitosis se refiere a la división natural del núcleo celular durante la 
reproducción celular; la diferenciación se refiere al grado de especialización de la célula para 
realizar una función específica en un organismo. 

 

 

RIESGOS DERIVADOS DE LA EXPOSICIÓN A LA RADIACIÓN  

Se estima que aproximadamente el 20 % (1 de cada 5) de todas las muertes producidas en los 
Estados Unidos se debe a algún tipo de cáncer. 

Si cada miembro de una población de 1 millón recibiera 10 mrem (0,1 mSv) de radiación, es 
posible que se observaran 5 muertes adicionales. Recuerde que, de esta población de 1 millón, 
cerca de 200 000 morirán de cáncer, lo que hace que estas pocas muertes adicionales sean 
estadísticamente imposibles de detectar. 

 2.3.1 Cont. 
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Además, el riesgo de muerte por cáncer es del 0,08 % por rem (10 mSv) para las dosis 
recibidas rápidamente (agudas) y puede ser 2 veces (0,04 %, o 4 de cada 10 000) menor que 
para las dosis recibidas durante un período de tiempo prolongado (crónicas). 

2.3.3 Cont. 
 

A partir de los datos actualmente disponibles, la Comisión Reguladora Nuclear de Estados 
Unidos (NRC, Nuclear Regulatory Comission) ha adoptado el valor de riesgo de una dosis 
profesional en 1 rem (0,01 Sv), que representa un riesgo de 4 de cada 10 000 de desarrollar 
un cáncer mortal. 

La Comisión Internacional de Protección Radiológica (publicación 103, 2007) indica un valor 
del 5,5 % por siévert para el cáncer y del 0,2 % por siévert para los efectos hereditarios tras la 
exposición a la radiación a baja tasa de dosis. 

El riesgo asociado a los usos diagnósticos de la radiación ionizante se limita normalmente a 
los efectos estocásticos tardíos, que se estima que ocurren con una frecuencia de, tal vez, el 
0,01 % para un examen promedio (en casos extremos, pueden producirse daños 
determinísticos en la piel tras una fluoroscopia). A nivel individual, estos riesgos son casi 
siempre pequeños, comparados con el beneficio del diagnóstico y el tratamiento.  

 

 

CONCLUSIONES SOBRE LOS RIESGOS PARA LA SALUD 

Asumimos que cualquier exposición a la radiación, por pequeña que sea, conlleva algún riesgo. 
Sin embargo, sabemos que, por término medio, estos riesgos son comparables o menores que 
los riesgos que encontramos en otras actividades u ocupaciones que consideramos seguras. 
Dado que tenemos un amplio control sobre la cantidad de exposición a la radiación que 
recibimos en el trabajo, controlamos y minimizamos este riesgo. El mejor enfoque es mantener 
nuestra dosis tan baja como sea razonablemente posible, o ALARA, término que discutiremos 
en detalle más adelante. Minimizar la dosis minimiza el riesgo. 

 

 

LÍMITES DE LA DOSIS MARCADOS POR LA CIPR 

La Comisión Internacional de Protección Radiológica (CIPR) ha establecido límites de dosis de 
radiación basados en los datos disponibles. Estos límites de dosis son valores máximos 
permitidos para las exposiciones anatómicas totales. La unidad de medida de la dosis se llama 
siévert (Sv), que tiene en cuenta varios factores de determinación de una cantidad llamada 
dosis efectiva. Los límites de la dosis se actualizaron por última vez en 2007. 

Para el público en general, el límite de la dosis es de 1 mSv/año (0,001 siévert por año) 

Para los trabajadores profesionales (los que trabajan en la industria nuclear), el límite de la 
dosis es de 20 mSv/año (0,02 siévert por año) 

Los límites de la dosis excluyen los efectos de la radiación de fondo. 

 

Límites de dosis anuales recomendados por la CIPR para órganos independientes o tejidos 
Dosis ponderada por radiación en Trabajadores Público 

Cristalino  150 mSv 15 mSv 
Piel 1,2  500 mSv 50 mSv 
Manos y pies  500 mSv - 

1. La limitación de la dosis efectiva proporciona suficiente protección para la piel contra los 
efectos estocásticos. Con el fin de prevenir las reacciones de los tejidos, se necesita un 
límite adicional para las exposiciones localizadas. 

2. Promedio de más de 1 cm2 de área de piel independientemente del área expuesta. 
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Factores determinantes 

Los efectos de la exposición a los rayos X dependen de la duración de la exposición, de la 
rapidez con la que se administre la dosis, de la energía (cuánta energía había en el rayo X), de 
la dosis total (de la magnitud de la dosis) y de si la exposición es de cuerpo entero o localizada. 
Los rayos X de baja energía (<50 KeV) pueden provocar daños solamente en la piel o a la parte 
externa del cuerpo, mientras que los rayos de alta energía pueden penetrar en el cuerpo hasta 
llegar a los órganos internos. Una dosis aguda y creativa que se administre de una vez tendría 
un efecto mayor que la misma dosis administrada a lo largo del tiempo en fracciones 
incrementales. 
 
En los entornos sanitarios, el riesgo de exposición a la radiación puede minimizarse: 

• Evitando todas las exposiciones innecesarias a la radiación 
• Empleando dosis que sean tan bajas como razonablemente alcanzables (ALARA) 
• Siguiendo las instrucciones de uso del fabricante del equipo 
• Siguiendo las instrucciones de mantenimiento preventivo de los fabricantes del equipo 
• Utilizando un blindaje apropiado 

 

 

ALARA 

El concepto ALARA se basa en el supuesto de que cualquier dosis de radiación, por pequeña 
que sea, puede tener algún efecto adverso. En virtud del ALARA, se utilizan todos los medios 
razonables para reducir la exposición. 

Para reducir la exposición de una persona a cualquier tipo de radiación ionizante, existen tres 
reglas generales. 

1. Reducir el tiempo de exposición a la fuente de radiación.  
• Al reducirse el tiempo de exposición, se reduce la dosis de radiación. 

2. Aumentar la distancia entre usted y la fuente de radiación. 
• El aumento de la distancia de una fuente de radiación reduce significativamente 

la dosis de radiación. 
• Duplicar la distancia de una fuente de radiación supone reducir la dosis a una 

cuarta parte. 
• Triplicando la distancia se obtiene una novena parte de la tasa. 

3. Aumentar el blindaje entre usted y la fuente de radiación.  
• El uso de un blindaje adecuado reduce enormemente la dosis. 
• El material utilizado y el espesor del blindaje dependen de la fuente de la radiación. 
• El plomo es un material común de blindaje. 

 

Consulte al responsable de protección radiológica las reglas y directrices específicas de su 
centro de trabajo. 

 
 
 
 
 
 
 

 2.5.0  
Gestión de riesgos 
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El sistema de radiografía digital de especímenes (DSR) Faxitron Core es un sistema 
compacto de cabina para escritorio de obtención de imágenes digitales de rayos X destinado a 
verificar rápidamente las biopsias core. 
 
Realizar directamente la verificación en la misma sala de biopsias permite que los casos se 
concluyan más rápidamente, limitando así el tiempo necesario para explorar al paciente. La 
radiografía de los especímenes puede limitar potencialmente el número de citas para los 
pacientes. El pequeño tamaño de Faxitron Core permite su instalación en áreas quirúrgicas u 
oficinas con espacio limitado. 
 
El sistema de radiografía digital de especímenes Faxitron Core utiliza Vision, un potente y 
completo software de adquisición de imágenes y manipulación de datos. El software Vision 
gestiona la obtención digital de las imágenes de rayos X, la calibración, la visualización de las 
imágenes, el análisis y la manipulación de las imágenes, la base de datos de los pacientes, el 
archivo de las imágenes y la transmisión. El software Vision constituye la parte central de este 
sistema. El software Vision es compatible con el estándar DICOM (Imagenología Digital y 
Comunicaciones en Medicina) 3.0 y dispone de impresión, almacenamiento y una lista de 
trabajo de modalidad (MWL) DICOM. 
 
 
Versión de DICOM 
 
Hologic utiliza el último estándar DICOM: 
Imagenología Digital y Comunicaciones en Medicina (DICOM) v3.0, desarrollado por ACR-
NEMA, versión definitiva, agosto de 1993. 
 
Y cumple el estándar: 
NEMA PS 3.1‑3.20 (2016), Equipo de Imagenología Digital y Comunicaciones en Medicina 
 
 
Clases de almacenamiento 
 
Faxitron DR cumple la norma relativa a la siguiente clase SOP (par servicio-objeto) de 
DICOM V3.0 como SCU (usuario de clase de servicio). 
 
Clase SOP como SCU 
 

Clase SOP UID (identificador único) 
de clase SOP 

SOP de almacenamiento de imágenes de radiografías 
computarizadas 

1.2.840.10008.5.1.4.1.1.1 

Presentación del almacenamiento digital de imágenes 
realizadas con rayos X 

1.2.840.10008.5.1.4.1.1.1.1 

Procesamiento de imágenes digitales realizadas con 
rayos X 

1.2.840.10008.5.1.4.1.1.1.1.1 

Presentación del almacenamiento de imágenes digitales 
de mamografías realizadas con rayos X 

1.2.840.10008.5.1.4.1.1.1.2 

Procesamiento de imágenes digitales de mamografías 
realizadas con rayos X 

1.2.840.10008.5.1.4.1.1.1.2.1 

Consulta o recuperación de la información raíz del 
estudio. Modelo -FIND 

1.2.840.10008.5.1.4.1.2.2.1 

Consulta o recuperación de la información raíz del 
paciente. Modelo -FIND 

1.2.840.10008.5.1.4.1.2.1.1 

Modelo -FIND de información de las listas de trabajo de 
las modalidades 

1.2.840.10008.5.1.4.31 

Almacenamiento de la presentación de las copias 
digitales en escala de grises 

1.2.840.10008.5.1.4.1.1.11.1 

 
 

Para conocer más detalles, consulte en su totalidad la declaración de conformidad de 
DICOM, que está almacenada en el sistema. El archivo está en C:\Faxitron, y hay un acceso 
directo en el escritorio. 
 

Si la necesita, puede solicitar a Hologic una copia de la declaración de conformidad de DICOM. 

 3.0.0 
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Mantenimiento 
 
En los equipos Hologic no hay piezas que se puedan reparar. Para recibir asistencia técnica, 
póngase en contacto con el representante autorizado de Hologic. 
 

EE. UU.: +1.877.371.4372 

Europa: +32 2 711 4690 

Asia: +852 37487700 

Australia: +1 800 264 073 

Resto del mundo: +1 781 999 7750 

Correo electrónico: BreastHealth.Support@hologic.com 
 
Solución de problemas 
 
Consulte el Manual de mantenimiento de Faxitron Core; póngase en contacto con el 
representante de Hologic o con el servicio de atención al cliente de Hologic. 
 
 
PROGRAMA DE MANTENIMIENTO 
 
Consulte el Manual de mantenimiento de Faxitron Core; póngase en contacto con el 
representante de Hologic o con el servicio de atención al cliente de Hologic. 
 
 
 
 
 
 

 3.0.2 
Mantenimiento  
y resolución de 
problemas 
 
 
 
 
 
 
 
 
 
 
 
3.0.3 
Programa de 
mantenimiento 
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DISTANCIAS entre la FUENTE y el GENERADOR DE IMÁGENES (SID) y entre la FUENTE 
y el OBJETO (SOD): 

• Desde la parte superior de la cámara hasta el generador de imágenes: 
0,230 pulgadas (5,8 mm) 

• Desde el blanco del tubo hasta el generador de imágenes: 12,90 pulgadas 
(327,66 mm) 

• Desde el blanco del tubo hasta la posición de la muestra:     8,94: (227,08 mm) 
• Desde el generador de imágenes hasta la posición de la muestra: 3,96 pulgadas 

(100,58 mm) 
• Ampliación efectiva: 1,44:1 

 
PESO: 40 libras (18 kg) 
 
REQUISITOS DE POTENCIA:  
máximo de 120 VCA, 60 Hz, 150 W o máximo de 230 VCA, 50 Hz, 150 W 
  
POTENCIA CALORÍFICA: máximo de 500 BTU/h 
 
CICLO DE TRABAJO DE LOS RAYOS X: 50 % 
 
CONTROL DE LA EXPOSICIÓN: automático o manual 
 
 
 

 3.1.0 
Especificaciones 
 
 
Figura 3.0.1  
Dimensiones y peso 
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Requisitos | Cumplimiento de Faxitron Core 

El centro o la institución que utilice este sistema será responsable de asegurar que se cumplan 
todas las normativas locales, regionales y federales que afecten al uso de equipos de radiación 
ionizante. 

 

Límites de emisión 

La radiación de rayos X emitida por la unidad Faxitron Core no excede una exposición de 0,3 
mili-Roentgens (mR) por hora en cualquier punto a 5 centímetros (cm) fuera de la superficie 
externa. Para los países que exigen valores de emisión medidos a 10 cm de la superficie 
exterior, la radiación no supera los 0,1 mR por hora a 10 cm. 

 

Enclavamientos de seguridad 

El sistema Faxitron Core de radiografías digitales de especímenes tiene dos enclavamientos 
de seguridad en el cajón de especímenes, el panel de acceso frontal y la cubierta trasera 
para evitar la generación de rayos X, a menos que estén cerrados o instalados. 

Botón Start (Inicio) 

Tras la interrupción de la generación de rayos X por los enclavamientos de seguridad, el 
botón Start (Inicio) del panel frontal reanudará la generación de rayos X cuando esté listo. 

Control accionado por llave 

El interruptor de cerradura con llave situado en el panel frontal requiere que se inserte y se 
gire una llave en el sentido de las agujas del reloj hasta la posición de las 3 para suministrar 
energía al sistema de cabina. La llave se mantiene fijada en la posición «ON» (Encendido). 

Botón Emergency Stop (Parada de emergencia) 

El botón Emergency Stop (Parada de emergencia) está disponible en el panel frontal del 
Faxitron Core para detener la generación de rayos X. Esto se suma a los enclavamientos de 
seguridad del cajón del sistema. 

Indicadores de generación de rayos X 

El Faxitron Core tiene un indicador luminoso de rayos X en el panel frontal y en la interfaz 
gráfica de usuario, y produce también un tono audible cuando se generan los rayos X. 

Acceso al software: contraseña opcional 

El usuario tiene la opción de implementar un requisito de «Contraseña» para abrir el software 
de Visión. Cuando esta opción está activada, se debe introducir la «contraseña definida por el 
usuario» correcta para abrir el software Vision. Si no se introduce la contraseña correcta, el 
software se cierra. 

 

 

Sistema de control de rayos X 

El sistema de control de rayos X consta de la electrónica del sistema, los cierres de 
enclavamiento de seguridad, el botón de encendido de los rayos X, el botón de parada de 
emergencia y el software de obtención de imágenes (Vision) del sistema. 

Para obtener imágenes o generar rayos X, el sistema Faxitron Core depende totalmente del 
software.  

 3.2.0 
Requisitos de 
cumplimiento  
y medidas de 
seguridad 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.0 
Sistema de control 
de rayos X 
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El software y el firmware del módulo de control supervisan las condiciones del sistema con el 
fin de determinar:  

1) Si se cuenta con el permiso para la obtención de imágenes  
2) Los parámetros de la obtención (el nivel de energía y la duración)  
3) Si debe suspenderse la obtención de imágenes  
4) Qué mensajes, si los hay, deberán mostrarse 
5) Qué indicadores deberán activarse. 

Para que se produzca la obtención de imágenes o la generación de rayos X, deberán cumplirse 
las siguientes condiciones: 

1) El software de Vision deberá estar abierto 
2) El sistema deberá estar armado (se habrán introducido los datos del paciente) 
3) Los cierres de enclavamiento deberán estar cerrados 
4) El módulo de control se comunica con el software del sistema (Vision) 
5) El generador de imágenes digitales se comunica con el software del sistema 
6) Botón de encendido de los rayos X pulsado 

Si se cumplen las condiciones anteriores, el software determinará los parámetros de obtención 
de las imágenes (el nivel de energía y la duración) y los enviará al módulo de control. El 
controlador procesará la señal y la enviará a la fuente de alimentación de alta tensión (HVPS). 
Si el circuito de alta tensión está activo, la HVPS generará alta tensión, que se enviará al tubo 
de rayos X, y se generarán los rayos X. Para informar al usuario de que la obtención de 
imágenes o generación de rayos X está en curso, se activarán los indicadores y los mensajes. 

Si en cualquier momento de la obtención de las imágenes se abriera un enclavamiento, la 
obtención se detendrá y se mostrarán los indicadores y mensajes pertinentes. 

 

Blindaje 
El sistema Faxitron Core está diseñado para generar energías de radiación ionizante iguales o 
inferiores a 30 keV. 

El acero inoxidable utilizado por el fabricante en el compartimento de rayos X Faxitron Core es 
un material de número atómico (Z) alto que absorbe con eficacia cercana al 100 % de la 
radiación ionizante a este nivel de energía.  

No es obligatorio blindarse más. 

Atenuación 

El haz primario procedente del tubo Faxitron Core de rayos X se dirige hacia el suelo del 
sistema. Cualquier rayo reflejado o disperso será absorbido por la parte superior, las paredes 
y el frontal del cajón del compartimento de rayos X. 

Las mediciones típicas de la radiación de fondo en la planta de fabricación de Hologic son de 
0,1 µSv/h (0,01 mR/h). 

Para representar los niveles máximos de energía del sistema y la dispersión máxima del haz, 
las mediciones de la dosis se toman a niveles de energía de 30 keV con un bloque de acrílico 
de 6 mm en la trayectoria del haz primario. Las mediciones realizadas en superficies accesibles 
suelen situarse entre 0,1 y 0,5 µSv/hora (0,01 y 0,05 mR/h). 
 

Hologic aboga por el seguimiento del principio «tan bajos como razonablemente alcanzables» 
(ALARA). Para realizar la tarea, use niveles de energía que no sean superiores a los 
necesarios. Para obtener una calidad de imagen que sea óptima, el uso del control automático 
de exposición (CAE) asegurará que se generen los niveles de energía de radiación ionizante 
más bajos posible. Con el CAE activado, el sistema expondrá brevemente la muestra a un nivel 
de energía y duración predeterminados. El software evaluará la imagen de la muestra 
y calculará los mejores ajustes de energía y tiempo. 

 3.3.0 Cont. 
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REQUISITOS NORMATIVOS 

El centro o la institución que utilice este sistema será responsable de asegurar que se cumplan 
todas las normativas locales, regionales y federales que afecten al uso de equipos de radiación 
ionizante. 

 

Advertencias 

• Antes de utilizar el sistema, lea atentamente las instrucciones. 

• No utilice el sistema de manera distinta a la del uso previsto, tal y como se describe en este 
manual; en caso de duda, póngase en contacto con Hologic o con el distribuidor autorizado. 

• No todos los cables de alimentación tienen la misma clasificación. No utilice con este sistema 
ningún otro cable de alimentación que no sea el suministrado. No utilice el cable de 
alimentación de este sistema en ningún otro equipo. 

• Este sistema ha sido probado siguiendo las normas internacionales más estrictas; no 
obstante, en lo relativo a los requisitos operativos locales es recomendable que se ponga en 
contacto con las autoridades nacionales. 

• Este sistema no está destinado al uso público. Deberá estar situado en una zona en la que 
el público en general no pueda acceder al sistema sin la presencia de un operador. 

• El uso de controles o los ajustes para realizar procedimientos distintos de los especificados 
en el presente documento podrá provocar la exposición peligrosa a la radiación. 

 

Precauciones generales 

Para evitar producir daños al sistema Faxitron Core, deberán tomarse las siguientes 
precauciones: 

• Mientras el sistema esté encendido, nunca conecte ni desconecte los cables de 
comunicación y/o alimentación. Si los cables se conectan o desconectan mientras la cámara 
está encendida, podrán producirse daños en el sensor CMOS o en los componentes 
electrónicos de la cámara. 

• El sistema de cámara es frágil y se debe tener cuidado para no dañarlo. El sistema de cámara 
nunca se deberá manipular incorrectamente, golpear bruscamente, golpetear ni dejar caer. 

• El sistema Faxitron Core dispone de un modo de calibración. Para garantizar el correcto 
funcionamiento del sistema, la calibración deberá llevarse a cabo diariamente. Consulte el 
Procedimiento de calibración en las secciones 5 y 6 de este manual. 

• Asegúrese de que el cajón de especímenes esté completamente cerrado antes de apagar la 
unidad. 

• Asegúrese de que el cajón de especímenes esté limpio y libre de especímenes o residuos 
antes de apagar la unidad. 

 

 4.0.0 
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Conexiones interoperativas 
El sistema Faxitron Core es capaz de funcionar como un dispositivo autónomo, sin entradas ni 
salidas hacia otros dispositivos. En el sistema, las imágenes se pueden captar, almacenar y 
revisar directamente. 

Sin embargo, el sistema dispone de varias interfaces. La interfaz principal es la conexión de 
red que permite conectar el sistema a un sistema de archivo y comunicación de imágenes 
(SACI). Las imágenes pueden ser transmitidas en formato DICOM desde el dispositivo 
directamente a la red del centro a través de nuestro software. Para obtener más detalles sobre 
la versión de DICOM, consulte la sección 6. Solamente deberán configurar esta comunicación 
los empleados de Hologic o el personal de TI capacitado del centro del usuario. 

A continuación, se enumeran las conexiones del sistema y el uso previsto. Ningún otro tipo de 
dispositivo deberá conectarse al Faxitron Core sin la aprobación de Hologic. 
 

 4.0.0 Cont. 

Conexión Propósito Tipo de dispositivo 
 

Usuarios a los que va dirigido 

Puerto Ethernet 
de la parte 
posterior 

Almacenar imágenes radiográficas en un 
sistema de almacenamiento de datos en 
red 

SACI o 
almacenamiento en 
red 

Configurado por el personal de 
Hologic o de TI del centro. Utilizado 
por profesionales clínicos.  

Puerto Ethernet 
de la parte 
posterior 

Permitir la conexión remota por parte del 
equipo de mantenimiento de Hologic 
para que Hologic pueda diagnosticar 
y reparar el sistema.  

Conexión a Internet 
en red 

Personal de Hologic o de TI 
del centro 

Puerto USB de 
la parte frontal 

Transferir imágenes desde el dispositivo. 
Este solamente se deberá utilizar si el 
SACI o la red no están disponibles.  

Dispositivo de 
almacenamiento 
USB (memoria flash) 

Profesionales clínicos o de TI 
que tenga acceso autorizado al 
sistema.  

Puerto USB de 
la parte frontal 

Mantener y conservar los archivos del 
sistema; es posible que sea necesario 
copiarlos en y desde el ordenador. Por 
ejemplo, actualizaciones de software o 
archivos de registro.  

Dispositivo de 
almacenamiento 
USB (memoria flash) 

Personal de Hologic o de TI 
del centro 

Puerto USB de 
la parte 
posterior 

Permitir la conexión de una impresora. El 
software Vision permite la conexión de 
una impresora DICOM o una impresora 
estándar compatible con Windows.  

Impresora DICOM o 
Windows 

Profesionales clínicos o de TI del 
centro 

 
 
Ciberseguridad 

La seguridad de los dispositivos es una responsabilidad compartida entre Hologic y los centros 
médicos. Si no se mantiene la ciberseguridad, se podrá poner en peligro la funcionalidad del 
dispositivo, la disponibilidad o la integridad por la pérdida de los datos (médicos o personales), 
o la exposición a amenazas de seguridad de otros dispositivos o redes conectados. Para 
asegurar la ciberseguridad de sus unidades y conservar su funcionalidad y seguridad, Hologic 
mantiene una serie de controles de ciberseguridad. 

Todas nuestras unidades utilizan sistemas operativos estándar de Windows. Durante la 
instalación, recomendamos que el centro implante todas las medidas de seguridad que sean 
necesarias y estén definidas por sus propios requisitos internos, como lo haría con cualquier 
otro PC conectado a la red. 

El centro podrá configurar el sistema operativo Windows con todos los protocolos de red y 
permisos necesarios. Por ejemplo, podrá añadir: 

• Las identificaciones (ID) de uso y las contraseñas, 
• La autorización por niveles con la autenticación correspondiente, 
• Restricciones a la instalación del software, 
• Requisitos de contenido de confianza, incluida la verificación del código de la firma, 
• Configurar las actualizaciones de Windows, incluidas las versiones de seguridad. 
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Además, nuestro software de imágenes (Vision) se puede proteger mediante contraseña para que 
determinados usuarios puedan acceder al sistema operativo sin tener que abrir el software Vision. 

La unidad viene con una llave física que enciende el sistema de rayos X. Esto permite que el 
sistema se bloquee, por lo que incluso si se accede al software no se pueden iniciar los rayos X. 

Esta unidad está diseñada para utilizarse como unidad independiente o conectarse al SACI 
interno del centro o a otra red de circuito cerrado. No está previsto que se conecte a Internet, 
a menos que: (a) el centro reciba de Hologic instrucciones específicas para hacerlo, o (b) el 
centro tome las precauciones adecuadas que garanticen la ciberseguridad de la unidad frente 
a las amenazas relacionadas con la conexión a Internet. 

Para seguir garantizando la seguridad de los productos, según sea necesario durante todo el 
ciclo de vida de la unidad, Hologic desarrollará actualizaciones o parches para el software de 
Hologic. 

Se podrán implementar medidas de seguridad adicionales, incluido el cifrado, y Hologic podrá 
trabajar con el departamento de TI de los centros para reducir el riesgo de los pacientes como 
resultado de la violación de la ciberseguridad. 
 
Eventos de ciberseguridad 
Si se produce un evento de ciberseguridad, desconecte de la red el sistema y póngase 
inmediatamente en contacto con Hologic. Trabajaremos con el departamento de TI del centro 
para resolver el problema. 

Un evento de ciberseguridad puede detectarse de varias maneras: 

• El funcionamiento y/o la conexión de red son más lentos de lo normal. 
• En el navegador de Internet aparecen ventanas emergentes sospechosas o la página 

de inicio ha cambiado. 
• La(s) contraseña(s) ya no funciona(n). 
• En el menú de inicio o en la bandeja del sistema hay programas desconocidos. 
• Los datos se han perdido, dañado o alterado. 

 
Limpieza 
Compartimento interno 

Las muestras que contienen especímenes biológicos pueden albergar agentes infecciosos que 
son peligrosos para la salud. Siga los correspondientes procedimientos de bioseguridad; cuando 
manipule especímenes de tejido o los materiales con los que entren en contacto, utilice guantes. 

La única parte del compartimento de rayos X accesible para la limpieza es el cajón de 
muestras. Puede limpiar suavemente el cajón de muestras con un paño suave sin pelusa 
humedecido con alcohol isopropílico al 70-90 % o hipoclorito de sodio diluido (la lejía doméstica 
al 5,25 %-6,15 % diluida en la proporción 1:500 ofrece la concentración adecuada).  

• No utilice abrasivos ni disolventes fuertes. 
• No frote el área de imagen rebajada del cajón, ya que esto puede rayar la superficie 

y crear artefactos de imágenes. 
• Para verificar que no dañan el material, pruebe los productos de limpieza en áreas 

pequeñas y poco visibles del cajón. 
 

Exterior 

Limpie periódicamente las superficies exteriores con alcohol isopropílico, hipoclorito de sodio, 
o agua con jabón suave (consulte más arriba las concentraciones correspondientes). 
No empape ni inunde las superficies, ni utilice abrasivos que puedan rayarlas. No permita que 
la humedad entre en contacto con ninguno de los componentes eléctricos del sistema. Para 
verificar que no dañan el material, pruebe los productos de limpieza en un área pequeña y poco 
visible de las cubiertas. 

 4.0.0 Cont. 
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Configuración del sistema 
El Faxitron Core debe configurarse por un representante autorizado de Hologic Inc. 

 
Inspección de las cajas 
El sistema Faxitron Core viene en una (1) caja de cartón. La caja contiene la cabina de rayos 
X Faxitron Core, el ordenador, el monitor, el cable de alimentación, el cable de vídeo, el 
cableado, la documentación, las llaves de la cabina de rayos X y 25 bandejas de muestras.  

Solicite al transportista que lleve la caja a un área donde pueda mantenerse a salvo de robos, 
daños o condiciones ambientales extremas hasta que el representante autorizado de Hologic 
Inc. pueda instalar el sistema. 

Compruebe si hay daños en la caja. Si observa algún daño, póngase en contacto con Hologic 
llamando al +1-800-447-1856. 

 

Elevación y transporte de las cajas 
Precaución: la caja pesa aproximadamente 80 libras (36,3 kg). La caja debe mantenerse en 

posición vertical, como aparece indicado en las etiquetas del envío. Tenga 
cuidado al trasladarla para evitar lesiones y daños al sistema. 

 
Desembalaje y configuración del sistema 
El sistema Faxitron Core debe ser desembalado y montado in situ por un representante 
autorizado de Hologic Inc. 

 

Ubicación 

Para permitir que la ventilación y el acceso al cable de alimentación y el cableado sean los 
adecuados, deje al menos 6 pulgadas (15 cm) de espacio libre detrás del armario cuando se 
instale. 

 

Condiciones ambientales 
Operativas: 

Temperatura:    entre 15,5 y 30 grados C (entre 60 y 86 grados F).  

Humedad relativa:    <75 %.  

Almacenamiento y transporte: 

Temperatura:   entre –20 y 50 grados C (entre –4 y 122 grados F).  

Humedad relativa:   <75 %. 

El equipo está diseñado para funcionar en las siguientes condiciones: 

• Uso en interiores, 
• Altitud hasta 2000 m (6562 pies), 
• Contaminación de grado 2, 
• Categoría de sobretensión II 

 4.1.0 
Configuración 
del sistema de 
especímenes 
Faxitron Core 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



 
 

MANUAL DE USUARIO DE FAXITRON CORE | HOLOGIC | REVISIÓN 001 
 

SECCIÓN 
Instalación y 
configuración 4 

4 - 6 

Faxitron® Core 
Sistema de radiografía de muestras 
 

REQUISITOS DE POTENCIA: máximo de 120 VCA, 60 Hz, 150 W o máximo de 240 VCA,  
50 Hz, 150 W 

POTENCIA CALORÍFICA: máximo de 500 BTU/h 

CICLO DE TRABAJO DE LOS RAYOS X: 50 % 

PROTECCIÓN RADIOLÓGICA: consulte la sección 2 de este manual. 

 

Faxitron Core fue diseñado como un sistema estacionario para ser instalado en un escritorio, 
mostrador o mesa. 

Traslado del sistema Faxitron Core: No recomendado. 
Una vez colocado en su ubicación final, se recomienda no trasladar el sistema Faxitron Core. 

El sistema Faxitron Core no está diseñado para ser una unidad portátil. Actualmente no se 
proporciona carrito, por lo que el sistema informático se colocará también en una superficie no 
portátil. 

 

Precaución: El armario de rayos X Faxitron Core pesa aproximadamente 40 libras (18 kg) y 
no está diseñado para ser levantado ni transportado. Es un instrumento de 
precisión que necesita ser manejado adecuadamente. No intente levantar ni 
cargar con el sistema. 

No bloquee el área situada detrás o inmediatamente delante de la unidad, ya que este espacio 
abierto es necesario para que se ventile el sistema y el ordenador. La ventilación en la parte 
posterior del sistema será la adecuada, siempre y cuando no se coloquen objetos entre la 
unidad y la pared donde está la toma de corriente eléctrica del sistema. 

Para que el personal pueda acceder con seguridad a la puerta de los especímenes, al teclado, 
al monitor y al panel de control del sistema, asegúrese de que haya una superficie plana y 
nivelada exenta de peligros delante del sistema. 
 

 Nota: Para acceder fácilmente al cable de alimentación del sistema, deje que haya 
suficiente espacio en la zona próxima al sistema. 
 

Precaución:  Si debe trasladar el sistema Faxitron Core: 
• Asegúrese de que todos los componentes estén completamente apagados. 
• Desconecte los cables de alimentación de la toma de corriente. 
• Desconecte todos los cables de interconexión (es decir, el cable de fibra óptica). 
• Tenga cuidado al trasladar el armario de rayos X Faxitron Core. 

 

Advertencia:  El cable de alimentación del sistema Faxitron Core viene suministrado con un 
enchufe que tiene conexión a tierra. Si no se dispone de una toma de corriente 
adecuada que coincida con el enchufe del cable de alimentación del sistema, 
solicite los servicios de personal cualificado para que le proporcione una toma 
de corriente eléctrica que sea adecuada. No intente modificar usted mismo el 
enchufe ni la toma de corriente. 

 
 
Advertencia:  Para evitar producir daños en la unidad y/o el contacto con tejidos infecciosos, 

asegúrese de que el Faxitron Core esté completamente limpio y debidamente 
embalado antes de retirarlo del uso para realizar el mantenimiento, 
transportarlo o eliminarlo. 

 4.1.0 Cont. 
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Antes de encender el sistema, asegúrese de que los cables de alimentación estén bien 
enchufados en la cabina Faxitron Core, en el ordenador y en el monitor antes de enchufarlos 
en la toma de corriente de alimentación de la red eléctrica de las instalaciones. También, si es 
necesario, conecte un cable de red Cat5 o Cat6 en la conexión de red del ordenador Faxitron 
Core y del centro médico. 

Consulte la sección 4 de este manual, Instalación y configuración, y las guías de configuración 
rápida y de inicio rápido suministradas con el sistema Faxitron Core. 

 
 
Procedimientos básicos de obtención de imágenes 
 
Advertencia:  El uso de Faxitron Core de una manera diferente a la descrita en este manual 

podría resultar en un mal funcionamiento del equipo o en lesiones personales. 
 
Advertencia:  Para evitar el contacto con muestras de tejido de pacientes que sean 

potencialmente peligrosas, utilice recipientes o guantes autorizados. 
 
Resumen de la secuencia de obtención de imágenes 
 
Para obtener el resumen del funcionamiento del sistema, consulte la guías de inicio rápido de 
Faxitron Core. 

• Abra el cajón de especímenes (pulse el botón negro). 
• Coloque los especímenes en un recipiente para especímenes proporcionado por Hologic, 

Inc. o su institución y colóquelos dentro del cajón Faxitron Core. 
• Cierre el cajón de especímenes (pulse el botón negro). 
• Elija o introduzca a un paciente en el software Vision e inicie la obtención de imágenes desde 

el software. 
• Pulse el botón verde Start (Comenzar) en el panel de control de Faxitron Core o en el 

software. Esto iniciará la exposición a los rayos X. 
• Espere a que se visualice la imagen. 
• Utilice el ratón para mover el cursor sobre la imagen visualizada y mueva el cursor hacia 

arriba y hacia abajo para ajustar los niveles de brillo u oscuridad, o muévalo hacia la izquierda 
o hacia la derecha para ajustar el contraste bajo o alto. Mueva el cursor hasta que la imagen 
esté al nivel deseado. 

• Repita el proceso para el resto de especímenes. 

Para obtener instrucciones de funcionamiento más detalladas, consulte la sección 5.2. 

Para obtener información sobre el funcionamiento avanzado del software, consulte la sección 6 
del Manual del usuario.  

 5.0.0 
Descripción 
general del inicio 
rápido 
 
 
 
 
Figura 5.0.1  
Panel frontal de Faxitron Core  
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Información general sobre la puesta en marcha 
El encendido (puesta en marcha del sistema) se lleva a cabo una sola vez al comenzar a 
utilizarse el sistema. Si tiene la intención de utilizarlo de nuevo, es recomendable que, una vez 
se haya realizado la secuencia de encendido, deje el sistema ENCENDIDO el resto del día. 
 
Protocolo de la secuencia de puesta en marcha del sistema 
Sistema de encendido 

• Ponga el ordenador y el monitor en la posición «ON» (Encendido) y permita que se 
inicie completamente en Windows. 

• Coloque el interruptor de alimentación en la parte posterior del 
armario Faxitron Core en la posición «ON» (Encendido). Véase la 
Figura 5.1.1. 

• Gire la cerradura de contacto de la parte frontal del armario 
Faxitron Core hasta «ON» (Encendido) (en el sentido de las 
agujas del reloj a la posición de las tres). Véase la Figura 5.1.2. 

• Verifique que no haya nada en el cajón de muestras Faxitron Core. 

 
 
 
 
 
 
 
 
 
Puesta en marcha del software 

• Haga «doble clic» en el icono de Vision situado en el escritorio de 
Windows. 

• Aparecerá brevemente un cuadro de diálogo para indicar que el 
software se ha inicializado y se está cargando. 

• El software se abrirá en la pantalla «Home Menu» (Menú de inicio) 
o «Calibration» (Calibración), dependiendo del tiempo transcurrido desde la última 
calibración. 

 
Si se ha llevado a cabo una calibración en las últimas 12 horas, el software se abrirá en Home 
Menu (Menú de inicio). 

Para garantizar una calidad de imagen óptima, Hologic recomienda calibrar el sistema cada día 
en el momento de la puesta en marcha o si el sistema se ha trasladado de lugar. 

Para iniciar una calibración de forma manual, haga clic en el botón Calibrate (Calibrar) de 
Home Menu (Menú de inicio) y, a continuación, haga clic en el botón Start Calibration (Iniciar 
calibración). El software volverá al Home Menu (Menú de inicio) cuando se complete la 
calibración. Véanse las Figuras 5.1.4 y 5.1.5. 

 

 

 

 5.1.0 
Secuencia de 
encendido  
 

5.1.1 
Puesta en marcha 
del sistema  
 
 
Figura 5.1.1  
Interruptor principal de 
encendido/apagado  
 
 
 
 
 

Figura 5.1.2  
Cerradura de contacto 
 
 
 
 
 
 
 
 
 

Figura 5.1.3  
Icono de escritorio de VISION 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 5.1.4  
Botón Calibrate (Calibrar) 
 
 
 
 
 
 

OFF  
(APAGADO) 

ON 
(ENCENDIDO) 

Apagado 
 

Encendido 
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Calibrar 
 NOTA: Para que la calidad de la imagen sea óptima, se recomienda calibrar el sistema al 

menos una vez al día, antes del primer uso. 
 

• El software se abrirá en la pantalla Calibration (Calibración) si han pasado 12 horas 
desde la última calibración. 

• Presione el botón Start Calibration (Iniciar calibración) y permita que el sistema 
complete la calibración. 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Se abrirá el cuadro de diálogo de calibración que mostrará el progreso de la calibración. 
 
 
 
 
 
 
 
 
 
 
• El cuadro de diálogo se cerrará cuando finalice la calibración. El software irá a la 

página Home Menu (Menú de inicio).  
 

 
 

 5.1.2 
Calibración 
 
 
 
 
 
Figura 5.1.5  
Botón Start Calibration 
(Iniciar calibración) 
 
 
 
 
 
 
 
 
 
Figura 5.1.6  
Cuadro de diálogo Calibración  
de rayos X 
 
 
 
 
 
 
 

Inicio del procedimiento de obtención de imágenes 

• En la página Home Menu (Menú de inicio) (véase la Figura 5.1.4), seleccione el botón Start 
Procedure (Iniciar procedimiento). 

• Al usuario se le darán las opciones de Select from Worklist (Seleccionar en la lista de 
trabajo), Manual Entry (Introducción manual), Select from Database (Seleccionar en la 
base de datos) o Continue with current patient (Continuar con el paciente actual). Véase 
la Figura 5.2.1. 

 

 5.2.0 
Obtención  
de imágenes 
 
 
 
 
Figura 5.2.1 
Botones para la introducción  
de datos del paciente 
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Para introducir manualmente un nuevo procedimiento, seleccione el botón Manual Entry 
(Introducción manual). 

 NOTA: Esta sección solamente versa sobre la «introducción manual» de los datos del 
paciente; las opciones restantes se tratan en la sección 6 de este manual. 

Se abrirá el cuadro de diálogo «Patient Information Editor» (Editor de la información sobre el 
paciente). 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Nota: Los campos obligatorios aparecen indicados con un 
asterisco blanco (*). Los campos obligatorios y predeterminados 
son: Patient Name (Nombre del paciente), Patient ID (Identificación 
del paciente), Accession Number (Número de ingreso) y Laterality 
(Lateralidad). 

 
Introduzca todos los campos obligatorios. Si falta algún campo obligatorio, el botón Accept 
(Aceptar) no estará activo. El usuario podrá completar otros campos si lo desea. 

 

 Nota: La fecha deberá indicarse como aaaa/mm/dd (por ejemplo, 1962/08/13). 

 

Para activar la obtención de imágenes, seleccione Accept (Aceptar). 

El sistema estará listo para obtener imágenes. 

 

 5.2.1 
Introducción 
manual de los 
datos del paciente 
 
 

Figura 5.2.2  
Editor de la información sobre la 
obtención de imágenes 
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Cómo realizar una imagen o comenzar la exposición a los rayos X 
Para obtener una imagen de rayos X con el sistema Faxitron Core: 

• Abra el cajón del compartimento de rayos X pulsando el botón negro y coloque la bandeja 
Faxitron Core con los especímenes en el cajón. Cierre el cajón pulsando de nuevo el botón 
negro.  

• Presione el botón verde Start X-Ray (Comenzar radiografía) en el panel de control o en el 
software. 

• Espere a que se visualice la imagen. 

 

 

 

 

 

 

 

 

 

 
 

 
 
 

 NOTA:  El modo predeterminado de rayos X del Faxitron Core es Full Auto (Totalmente 
automático). El sistema realizará dos radiografías; la primera, para determinar los 
ajustes óptimos, y la segunda, para obtener la imagen. Los ajustes utilizados 
durante las exposiciones se mostrarán en la pantalla LCD de los armarios. 

 
El software Vision está configurado para guardar automáticamente la imagen en la base de datos 
de Faxitron, en la unidad local del ordenador del sistema. El usuario también puede guardar la 
imagen en el servidor de instalaciones haciendo clic en el icono «PACS» (SACI). Consulte las 
secciones 6.4.1, 6.6.0 y 6.7.0 para obtener más información sobre cómo guardar las imágenes. 
 
Para obtener más información sobre cómo ajustar la configuración de las imágenes, los 
controles de rayos X y las opciones de revisión y guardado, consulte la sección 6. 

 5.2.2 
Cómo comenzar 
una exposición 
 
 
 
 
 
 
 
Figura 5.2.3 
Cajón Faxitron Core 
 
 
 
 
 
 
 
 
 
 

 
Salir del software VISION 
Haga clic en el botón Shut Down (Apagado) y, a continuación, haga clic en OK (Aceptar). Esto 
apagará el equipo. El apagado se puede seleccionar en la pantalla de inicio o en la pantalla de 
obtención de imágenes utilizando los botones siguientes.  

 

Botón Shut Down (Apagado) en la pantalla Acquisition 
(Obtención). 

 

Botón Shut Down (Apagado) en el Home Menu (Menú de inicio). 

   

Apague el armario de rayos X Faxitron Core 
Una vez que el ordenador esté apagado, gire la cerradura de contacto hasta la posición de 
apagado (posición vertical). 

 5.2.3 
Cómo apagar  
del sistema 
 
Figuras 5.3.1 y 5.3.2. 
Botones de Shut Down (Apagar  
el sistema) y salir del programa 
 
 

 

Botón del cajón 

Botón X-Ray 
(rayos X) 

Botón  
«Start X-Ray» 

(Comenzar radiografía) 
en la pantalla 
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El software Vision es un completo paquete de obtención y procesamiento de imágenes que 
está diseñado exclusivamente para trabajar con los generadores de rayos X de Hologic (como 
los sistemas VersaVision, Faxitron Path, Faxitron Core y Faxitron OR). Además de las 
funciones de obtención y procesamiento, el software ofrece un amplio módulo de base de 
datos, que permite el control y el mantenimiento de archivos, y el almacenamiento, la 
tramitación y la recuperación de las imágenes por parte del usuario. El software también es 
compatible con Imagenología Digital y Comunicaciones en Medicina (DICOM), lo que permite 
guardar e imprimir imágenes de los pacientes en formato DICOM 3.0. El software ha sido 
preinstalado en el ordenador que se incluye con el sistema de rayos X. 
 
Para obtener la mejor calidad de las imágenes, será necesario calibrar el sistema cada nuevo 
día de uso. Para garantizar que la calidad de las imágenes sea óptima, el usuario del sistema 
también podrá realizar la calibración en cualquier momento. 
 
Después de la calibración, se mostrará Home Menu (Menú de inicio), que permite navegar al 
resto de áreas del software. Para facilitar el uso, se proporcionan botones de aplicación. Véase 
la Figura 6.0.1. Estos botones están en el centro de la pantalla. Las descripciones y definiciones 
de los botones aparecen explicadas en las próximas secciones de este manual.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Protocolo de la secuencia 
 
Para garantizar que la funcionalidad del sistema y la calidad de las imágenes sean las 
adecuadas, deberá seguirse esta secuencia de puesta en marcha: 

• Encienda la cabina Faxitron Core utilizando el interruptor situado en la parte posterior de la 
cabina (el interruptor de alimentación está junto a la toma de corriente del cable de 
alimentación). Pulse «l» para «ENCENDERLO» y «0» para «APAGARLO». 

• «ENCIENDA» el sistema Faxitron Core introduciendo la llave Faxitron Core en el interruptor 
de cerradura con llave, situado en el panel frontal, y girándola en el sentido de las agujas del 
reloj hasta la posición de las 3.  Nota: La llave no se puede extraer en esta posición. 

• Encienda el ordenador y el monitor. 

• Si Vision no se inicia automáticamente, haga doble clic con el botón 
izquierdo del ratón en el icono del software Vision (ubicado en el 
escritorio de Windows). Véase la Figura 6.1.1. Aparecerá brevemente un 
cuadro de diálogo para indicar que el software se ha inicializado y se está 
cargando. 

• El software Vision se abrirá en Home Menu (Menú de inicio) (véase la 
Figura 6.0.1) o en la página Calibration (Calibración) (véase la Figura 6.2.2), dependiendo 
del tiempo transcurrido desde la última calibración del sistema. 

• Consulte los protocolos de calibración en la sección 6.2.0 «Descripción general de la 
calibración de la cámara». 

 6.0.0 
Descripción 
general del 
software Vision  
 
 
 
 
 
 
 
 
 
 
 
 

Figura 6.0.1  
Home Menu (Start-up Screen) 
(Menú de inicio [pantalla de 
puesta en marcha]) del  
software Vision  
 
 
 
 
 
 
 
 
 
 
 
 

6.1.0 
Puesta en marcha 
del software  
 
 
 
 
 
 
 
 
Figura 6.1.1  
Icono de escritorio del software 
Vision 
 
 



 
 

MANUAL DE USUARIO DE FAXITRON CORE | HOLOGIC | REVISIÓN 001 
 

SECCIÓN 
Software 
Vision 6 

6 - 3 

Faxitron® Core 
Sistema de radiografía de muestras 
 

Introducción a la calibración 
 
Para optimizar la calidad de las imágenes, el software Vision y el hardware requieren la 
realización periódica de la calibración. Esta calibración requiere la obtención de imágenes de 
referencia.  
 
En el momento de la puesta en marcha inicial del sistema, o en cualquier momento deseado 
por el usuario, se podrá solicitar y realizar la calibración del sistema. Se recomienda que, 
transcurrido un periodo de doce (12) horas, se realicen las siguientes calibraciones. 
 
Estas imágenes de calibración de referencia se utilizan para calibrar, píxel por píxel, una 
imagen de rayos X «sin procesar» con el fin de generar una imagen «corregida», que será 
visualizada. Las correcciones realizadas a la imagen abarcan correcciones de ganancia, 
contraste y linealidad. 
 

Secuencia de la calibración 
 
Para mayor comodidad, el software Vision combina los numerosos pasos de calibración en un 
solo paso unificado. 
 
Cuando un sistema de rayos X de Hologic ha estado apagado durante más de doce (12) horas, 
el sistema solicitará automáticamente que se vuelva a calibrar. Se recomienda 
encarecidamente que el sistema se vuelva a calibrar tras períodos prolongados de inactividad 
o después de que el sistema se traslade de una estancia a otra que tenga unos parámetros de 
temperatura o humedad ambiente potencialmente diferentes.  
 
Para calibrar el sistema en cualquier momento, haga clic en el 
botón Calibrate (Calibrar) en Home Menu (Start-up Screen) (Menú 
de inicio [Pantalla de puesta en marcha]) de Vision y, a 
continuación, presione Start Calibration (Iniciar calibración). 
Véanse las Figuras 6.2.1 y 6.2.2. Durante la calibración, el diálogo 
mostrará un mensaje de estado. Véase la Figura 6.2.3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Durante la calibración, puede que se generen rayos X. Durante la generación de rayos X, se 
hará visible el botón Stop X-Ray (Detener rayos X) para permitir que el usuario tenga la opción 
de detener los rayos X utilizando el software. 

 6.2.0 
Descripción 
general de la 
calibración de la 
cámara 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 6.2.1  
Botón Calibrate (Calibrar)  
del Menú de inicio 
 
 
 
 
 

Figura 6.2.2  
Botón Start Calibration  
(Iniciar calibración) 
 
 
 
 
 
 
 
 
Figura 6.2.3  
Estado de la calibración 
 
 

 



 
 

MANUAL DE USUARIO DE FAXITRON CORE | HOLOGIC | REVISIÓN 001 
 

SECCIÓN 
Software 
Vision 6 

6 - 4 

Faxitron® Core 
Sistema de radiografía de muestras 
 

A continuación se presenta un resumen del protocolo de calibración avanzada para «ambos» 
(el campo plano y la imagen): 
Coloque el atenuador uniforme sobre el sensor. Toda la superficie del sensor deberá estar 
cubierta por el atenuador. Para obtener resultados ideales, el atenuador deberá ser mayor que 
el área de obtención de imágenes del sensor. 
Para enfocar el menú, desde el Home Menu (Menú de inicio) del software de obtención de 
imágenes, presione el icono ^ situado arriba a la derecha. En el menú horizontal situado en la parte 
superior de la pantalla, seleccione el elemento del menú desplegable «Tools» (Herramientas) y, a 
continuación, vaya hasta «Advanced Tools» (Herramientas avanzadas) y, después, hasta «X-Ray 
Calibration/Exposure Setup» (Calibración de rayos X/Configuración de la exposición). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 NOTA: Los valores de kV, el tiempo de exposición y las unidades 
analógico-digitales (UAD) podrían ser diferentes de los mostrados. 

• En «X-Ray Generator and Exposure Settings» (Generador de rayos X y ajustes de la 
exposición), introduzca el ajuste de kV del generador en el campo correspondiente. 

• Deje la «Magnification» (Ampliación) en el ajuste predeterminado de 1,450 (la ampliación 
está fijada en el sistema Faxitron Core). 

• En el cuadro de diálogo, seleccione el botón «Set for» (Ajustar para) «Both» (Ambos). 
• Deje el ajuste predeterminado «user ADU target» (blanco de las UAD del usuario). 

La exposición a los rayos X se interrumpirá cuando el sensor haya acumulado un nivel medio 
de señal de UAD que sea aceptable para el generador de rayos X que usted tiene. 

• Deje el tiempo de exposición predeterminado de la prueba y haga clic en el botón Acquire 
(Obtener). El sistema dará inicio automáticamente a los rayos X y obtendrá una imagen. 

• Cuando la exposición a los rayos X haya finalizado, haga clic en el botón Estimate/Calculate 
(Estimar/Calcular). 

• Registre la lectura del tiempo de exposición «Time[s]» (Tiempo[s]) calculado. El sistema 
calculará este tiempo y el número aparecerá en gris. 

• Introduzca la lectura del tiempo de exposición «Time[s]» (Tiempo[s]) calculado en la casilla 
de tiempo «Test Exposure» (Exposición de prueba). Para dar inicio automáticamente a los 
rayos X y obtener una imagen, presione el botón Acquire (Obtener). 

• Cuando la exposición a los rayos X haya finalizado, haga clic en el botón Estimate/Calculate 
(Estimar/Calcular). 

• Registre la lectura del tiempo de exposición «Time[s]» (Tiempo[s]) calculado. 
• Vuelva a introducir la lectura del tiempo de exposición calculado en la casilla de tiempo «Test 

Exposure» (Exposición de prueba). 

 6.2.0 Cont. 
 
 
 
 
 
 
 

Figura 6.2.4  
X-Ray Generator and Exposure 
Dialog Box (Generador de 
rayos X y cuadro de diálogo  
de la exposición) 
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• Haga clic en el botón Accept Settings (Aceptar configuración). 

• Realice un procedimiento estándar de calibración, tal y como se describe en la sección 
«Descripción general de la calibración de la cámara». 

Como se describió anteriormente, puede que los usuarios experimentados quieran ajustar  
«X-Ray Cal (Flat-Field)» (Calibración de rayos X [Campo plano]) y «Manual Image» «Exposure 
Settings» (Imagen manual) (Ajustes de la exposición) por separado o «Both» (Ambos) (el 
campo plano y la imagen manual). Seleccionando el botón de opción «Flat Field» (Campo 
plano), el sistema determinará el tiempo de exposición óptimo para obtener imágenes de 
campo plano al nivel de UAD deseado. Por consiguiente, la selección de «Manual Image» 
(Imagen manual) determinará el tiempo de exposición óptimo para el sistema con un objeto 
que atenúe la señal de rayos X. Para obtener los mejores resultados, el objeto deberá cubrir 
toda el área de obtención de imágenes del sensor. 

Después de seleccionar «X-Ray Cal (Flat-Field)» (Calibración de rayos X [Campo plano]) o 
«Manual Image» (Imagen manual), se ha ajustado el nivel de UAD; seleccione el botón Acquire 
(Obtener). Para seleccionar «Manual Image» (Imagen manual), conviene tener el objeto o el 
atenuador de rayos X en el haz de rayos X. Para generar rayos X y obtener una imagen, pulse 
el botón Acquire (Obtener). Cuando la exposición a los rayos X haya finalizado, haga clic en 
el botón Estimate/Calculate (Estimar/Calcular). El sistema calculará el tiempo óptimo y el 
número aparecerá en gris. Para guardar los «Exposure Settings» (Ajustes de exposición) en el 
archivo de configuración del sistema, haga clic en el botón Accept Setting (Aceptar ajuste).  

 Nota: Solamente se guardarán los ajustes del botón de opción que haya seleccionado.  

A continuación, realice un procedimiento estándar de calibración, tal y como se describe en la 
sección «Descripción general de la calibración de la cámara». 

 

Periódicamente, convendría incorporar las características de atenuación de los rayos X de un 
atenuador uniforme en las imágenes de calibración de referencia de campo plano. Por ejemplo, 
si todos los objetos radiografiados se colocan sobre una placa plástica delgada, las 
características de atenuación de los rayos X de la placa se observarán en cada imagen 
obtenida. En este caso, la colocación de la placa dentro del haz de rayos X, durante la obtención 
de la imagen de calibración de referencia de campo plano, podría mejorar la calidad de las 
imágenes. 

 
 
 
 

El botón Start Procedure (Iniciar procedimiento) (véase la Figura 6.0.1) lleva al usuario a la 
página Patient Data Entry (Introducción de datos del paciente), que proporciona métodos para 
introducir los datos de los pacientes. Si no se ha configurado una lista de trabajo, la opción 
aparecerá en gris y solamente se podrá acceder a las opciones Continue with Current Patient 
(Continuar con el paciente actual), Manual Entry (Introducción manual) y Select from Database 
(Seleccionar en la base de datos). Las opciones aparecen explicadas en las siguientes 
secciones. 
 

 6.2.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.2.1 
Calibración 
avanzada 
 
 
 
 
 
 
6.3.0 
Datos del paciente 
 
 
 
 
 
 
Figura 6.3.1 
Pantalla Patient Data Entry 
(Introducción de datos del 
paciente) 
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Select from Work List (Remote Modality Work list) (Seleccionar en 
lista de trabajo [Lista de trabajo de modalidad remota]) 

Si se ha configurado una lista de trabajo, el usuario podrá hacer clic en el botón Select from Work 
List (Seleccionar en la lista de trabajo), que mostrará la página que aparece en la Figura 6.3.2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
A la izquierda hay varios filtros que pueden utilizarse para buscar procedimientos programados 
para la entidad de aplicación (AE) de la terminal. Verifique que esté definido el título AE de la 
terminal; a continuación, cualquier campo individual o cualquier combinación de campos podrá 
utilizarse como filtro para buscar procedimientos programados para este AE. Seleccionando el 
botón Query (Consulta), situado en la esquina inferior izquierda, la tabla se rellenará con las 
entradas que coincidan con la información consultada. 

El usuario podrá entonces hacer clic en cualquier entrada y pulsar Submit (Enviar) para rellenar 
automáticamente el editor de la información sobre la obtención de imágenes con la información 
del paciente. 

AVISO: El usuario también podrá hacer doble clic en cualquier entrada de la tabla para acceder 
rápidamente al editor de la información sobre la obtención de imágenes sin tener que presionar 
Submit (Enviar). 

Se abrirá el editor de la información sobre la obtención de imágenes Patient Information Dialog 
(Diálogo de información sobre el paciente). Véase la Figura 6.3.3. Para proceder a la obtención 
de imágenes, rellene el resto de los campos obligatorios y haga clic en Accept (Aceptar). 

 6.3.1 
Seleccionar en la 
lista de trabajo 
 
Figura 6.3.2 
Diálogo de búsqueda en la lista de 
trabajo de la modalidad 

 NOTA: Todos los datos de los 
pacientes son ficticios.  
Cualquier parecido con personas 
reales es pura coincidencia. 
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 Nota:  Los campos obligatorios aparecen 

indicados con un asterisco blanco 
(*). Los campos obligatorios y 
predeterminados son: Patient Name 
(Nombre del paciente), Patient ID 
(Identificación del paciente), 
Accession Number (Número de 
ingreso) y Laterality (Lateralidad). 

 
Antes de poder seleccionar el botón Accept 
(Aceptar), el usuario deberá introducir todos los 
campos obligatorios. Si así lo desea, el usuario 
también podrá introducir los campos Date 
(Fecha), Referring Physician (Médico 
remitente), Procedure Name (Nombre del 
procedimiento), Sex (Sexo), Technician 
(Técnico), Position View (Vista de la posición), 
Body Part (Parte anatómica) y Study ID 
(Identificación del estudio). El nombre del 
procedimiento, la vista de la posición y la parte 
anatómica se eligen mediante un menú 
desplegable. 
 

 Nota:  La fecha deberá introducirse en el 
formato aaaa/mm/dd (por ejemplo, 
1962/08/13). Si no se introduce la 
fecha válida, se podrán producir 
errores al intentar recuperar las 
imágenes.  

 
 Nota:  En función de la aplicación, «los 

campos obligatorios» pueden ser 
modificados o eliminados. Póngase 
en contacto con el servicio de 
asistencia técnica de Hologic para 
obtener más información. 

 
Para regresar a la página de introducción de datos de los pacientes, seleccione Accept 
(Aceptar) para continuar o Start a New Patient or Procedure (Iniciar un paciente o 
procedimiento nuevo). 

 6.3.1 Cont. 
 
Figura 6.3.3 
Editor de la información sobre la 
obtención de imágenes 
 

 
 
 Continue with Current Patient (Continuar con el paciente actual) 

 
Haga clic en este botón para continuar con el procedimiento del paciente actual. Se abrirá 
«Image Information Editor» (Editor de la información de las imágenes). Véase la Figura 6.3.3. 
Siga el procedimiento y las notas anteriores. 
 
 
 

 6.3.2 
Continue with 
Current Patient 
(Continuar con el 
paciente actual) 

 
Manual Entry (Introducción manual) 

 
Haga clic en este botón para introducir manualmente un nuevo procedimiento. Se abrirá el 
«Image Information Editor» (Editor de la información de las imágenes). Véase la Figura 6.3.3. 
Siga el procedimiento y las notas anteriores. 

 
 

 6.3.3 
Manual Entry 
(Introducción 
manual) 
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Select from Database (Seleccionar en la base de datos) 
 
 
Si selecciona el botón Select from Database (Seleccionar en la base de datos), aparecerá la 
siguiente página. Véase la Figura 6.3.4 siguiente. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
El usuario selecciona a un paciente en la tabla situada en el lado derecho de la página y, a 
continuación, hace clic en el botón Accept (Aceptar), que abre el editor de la información sobre 
las imágenes. (  Nota: Para abrir el editor de información sobre las imágenes, el usuario 
también puede hacer doble clic en la entrada de la tabla). A continuación, siga el procedimiento 
y las notas de la página 6-7. 

 Nota: Para ver la información oculta de los pacientes, utilice la barra de desplazamiento 
situada en la parte inferior de la pantalla. 

Vision permite al usuario reducir la lista de pacientes introduciendo información específica en 
la ventana «Search Parameters» (Parámetros de búsqueda) situada en el lado izquierdo de la 
página. Solamente se mostrarán aquellos pacientes que coincidan con todos los parámetros 
de búsqueda.  

 

 6.3.4 
Select from 
Database 
(Seleccionar en la 
base de datos) 
 
Figura 6.3.4 
Selección de pacientes en las 
entradas de la base de datos local 
 
 

 

 NOTA: Todos los datos de los 
pacientes son ficticios.  
Cualquier parecido con personas 
reales es pura coincidencia. 
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Si el usuario desea cambiar o ver la información después de haberla introducido, 
pero antes de haber tomado una imagen, podrá hacer clic en el icono Patient 
Data (Datos del paciente) situado en la esquina superior izquierda de la pantalla. 
Véase la Figura 6.3.5. 

 
Se abrirá la ventana de edición de la información sobre el paciente o sobre la obtención de 
imágenes. Esta ventana de edición se rellenará con toda la información que se haya 
introducido o seleccionado previamente. Véase la Figura 6.3.6.  Nota: La ventana de 
edición incluirá ahora el botón Cancel (Cancelar). 
 
El usuario podrá cambiar o añadir la 
información que desee y luego hacer clic en: 

• el botón Accept (Aceptar) para guardar los 
cambios y continuar con la obtención de 
imágenes; 

• el botón Cancel (Cancelar) para cancelar 
los cambios y continuar con la obtención de 
imágenes. El software volverá a la 
información original sobre el paciente que se 
haya introducido, o 

• el botón Start a New Patient or Procedure 
(Iniciar un paciente o procedimiento nuevo), 
que devolverá al usuario a la pantalla de 
introducción de datos del paciente. Véase la 
Figura 6.3.1.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Una vez que el usuario haga clic en el botón Accept (Aceptar), el sistema estará listo para 
obtener imágenes o radiografías. 

Las radiografías se comenzarán presionando el botón verde Start (Comenzar) en la parte 
frontal de la cabina Faxitron Core o haciendo clic en el botón Start X-Ray (Comenzar 
radiografía) situado en la esquina inferior derecha de la pantalla. Véase la Sección 5.2.2: Cómo 
comenzar la exposición. El sistema tomará una breve radiografía «de muestra», o una toma 
previa (que se explica en la sección 6.4.4), seguida de una exposición más prolongada para 
obtener la imagen. El software procesará la imagen antes de que se muestre en la pantalla del 
monitor. Una vez visualizada la imagen, se activarán los botones situados en los lados 
izquierdo y derecho de la pantalla, tratados en toda esta sección.  

 6.3.5 
Icono de datos del 
paciente 
Figura 6.3.5 
Icono de datos del paciente 
 
 
 
 
Figura 6.3.6 
Editor de la información sobre la 
obtención de imágenes 
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Después de obtener una imagen, el usuario podrá 
ver, pero no editar, la información del paciente 
haciendo clic en el icono Patient Data (Datos del 
paciente) que se muestra en la Figura 6.3.5. Esto 
mostrará un cuadro de diálogo modificado Patient 
Information (Información sobre el paciente), como 
se muestra en la Figura 6.3.7. Este cuadro 
proporciona dos botones: Close Dialog (Cerrar 
diálogo) o Start a New Patient or Procedure (Iniciar 
un nuevo paciente o procedimiento). Después de 
obtener una imagen, el usuario podrá ver, pero no 
editar, la información del paciente haciendo clic en 
el icono Patient Data (Datos del paciente) que se 
muestra en la Figura 6.3.4. Esto mostrará un cuadro 
de diálogo modificado Patient Information 
(Información sobre el paciente), como se muestra 
en la Figura 6.3.7. Este cuadro proporciona dos 
botones: «Close Dialog» (Cerrar diálogo) o «Start a 
New Patient or Procedure» (Iniciar un nuevo 
paciente o procedimiento).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Una vez tomada la imagen, se 
podrán ver las propiedades de 
la imagen actual pulsando el 
icono (i) situado en la esquina 
superior derecha. Véase la 
Figura 6.3.8. Aparecerá el 
cuadro de diálogo Image 
Properties (Propiedades de la 
imagen) en la esquina superior 
derecha de la imagen. El cuadro 
es semitransparente para 
permitirle a uno ver lo que hay 
por debajo del cuadro. Véase la 
Figura 6.3.9. 

 
 

 6.3.5 Cont. 
 
Figura 6.3.7 
Diálogo de información sobre el 
paciente tras obtener las imágenes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.3.8 
Icono Propiedades de la imagen 
 
 
Figura 6.3.9 
Propiedades de la imagen  
(solo lectura) 
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El software Vision proporciona varias herramientas y menús para controlar varios atributos o 
parámetros de las imágenes, la obtención de rayos X, las vistas de imagen, las herramientas 
de imagen y los ajustes o accesos de DICOM. Las herramientas más utilizadas están situadas 
en una barra de herramientas. La barra de herramientas y los menús se describen con más 
detalle en las próximas páginas.  

 
Con un solo clic, el software Vision permite acceder a una serie de herramientas o funciones de 
uso común con una barra de herramientas vertical ubicada en el lado izquierdo de la pantalla. 
En las páginas siguientes se ofrecen descripciones más detalladas. Véase la Figura 6.4.1. 

 

 

Ver o modificar la información  
 sobre el paciente 
 
(Véase la sección 6.3.5 y Figura 6.3.5) 
 

Icono de mejora de la imagen 
 
 
 

Herramienta Nivel de la ventana  
y contraste 
 
 
Herramienta Zoom digital 
 
 
 
Herramientas de anotación 
 
 
 

Guardar en SACI 
 
 
 
Impresión en SACI 
 
 
 
Control de la exposición (Panel de control del dispositivo) 
 
 
 
Volver al menú principal 
 
 
 
Apagado del sistema 
 

 
 

 6.4.0 
Barra de 
herramientas  
y menús 
 
6.4.1 
Barra de 
herramientas lateral 
 
 
 
Figura 6.4.1 
Barra de herramientas lateral  NOTAS: 

 
Las siguientes herramientas están 
siempre activas en la página de 
obtención de imágenes: 
• Ver o modificar la información sobre 

el paciente 
• Control de la exposición 
• Volver al menú principal 
• Apagado del sistema 
 
Las siguientes herramientas se 
desactivarán después de introducir los 
datos del paciente y solamente se 
activarán tras obtener una radiografía: 
• Mejorar la imagen 
• Nivel y contraste de la ventana 
• Zoom digital 
• Anotación 
 
Las herramientas PACS Save 
(Guardar en SACI) y PACS Print 
(Impresión en SACI) solamente se 
activarán después de realizar una 
radiografía y cuando el sistema esté 
conectado a una red SACI. 
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Mejorar imagen 
 
El botón mostrado en la Figura 6.4.2 procesará la imagen en la pantalla para enfatizar en la 
imagen los detalles más pequeños, como las microcalcificaciones y las pequeñas 
masas.  
 
 

En la obtención de imágenes avanzadas, el algoritmo comúnmente denominado «ecualización 
periférica» o «ecualización del espesor» se aplica a toda la imagen. Además de este algoritmo, 
Hologic emplea un segundo algoritmo desarrollado internamente y llamado «énfasis de las 
calcificaciones». Este algoritmo secundario fue creado para resaltar pequeños detalles de la 
imagen y hacerlos mucho más fáciles de ver y analizar.  
 
Dado que las imágenes de los pacientes constituyen una categoría más general en cuanto a 
las posibles geometrías y la variedad de espesores, puede que haya geometrías de las 
muestras que representen un reto, y el usuario deberá utilizar esta herramienta con cuidado.  
 
El sistema estará inactivo (en espera) durante el proceso y, una vez finalizado, el botón 
permanecerá pulsado o activo. El usuario podrá deshacer el proceso pulsando de nuevo el 
botón. 
 
 
 
 
 
 
 
 
 

 6.4.1 Cont. 
  
 
Figura 6.4.2  
Icono de mejora de la imagen  
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Ajuste de la inversión, el nivel de la ventana y el contraste 
 
El botón, mostrado en la Figura 6.4.3, abrirá la herramienta de ajuste Window Level and 
Contrast (Nivel de la ventana y contraste). Esta herramienta permite al usuario ajustar el nivel 
de la ventana y el contraste de la imagen. El usuario también podrá restaurar el contraste 
original pulsando el botón Original Contrast (Contraste original) o invertir la imagen pulsando 
el botón Invert (Invertir). La inversión cambia el esquema cromático de ser predominantemente 
negro a ser predominantemente blanco, o viceversa. Véase la Figura 6.4.4 siguiente. 
 
 
 
 
 
 
 
 
 
 
 
 
El usuario también podrá ajustar con la barra deslizante el 
contraste de la imagen deseado haciendo clic en la barra y 
moviéndola hacia arriba y hacia abajo, o haciendo clic en 
cualquiera de las flechas de la barra, para mover los límites 
inferior o superior del nivel de la ventana. Véase la Figura 6.4.3 
(informalmente también se denomina «Equilibrado de la 
ventana»). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A continuación se muestra el ejemplo de una inversión: 
 

 6.4.1 Cont. 
 
 
 
 
 
 
Figura 6.4.3 
Iconos y controles de la 
herramienta Window Level and 
Contrast (Nivel de la ventana  
y contraste) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.4.4 
Ejemplo de inversión con la 
herramienta Nivel de la ventana  
y contraste 
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Ajuste del zoom dinámico 
 
El icono Zoom Tool (Herramienta Zoom), Figura 6.4.5, abrirá la herramienta de ajuste del 
zoom. Después de abrir esta herramienta, el usuario podrá utilizar la barra deslizante para 
ajustar el nivel del zoom o hacer clic en los botones Fit to Specimen (Ajustar al espécimen), 
Fit to Screen (Ajustar a la pantalla) o Zoom 1.0x (resolución completa). Véase la Figura 6.4.6. 
Para navegar por toda la imagen, cuando esta haya sido ampliada, será necesario realizar una 
panorámica. Aparecerá un cuadro de diálogo en miniatura en la esquina superior izquierda de 
la pantalla. Véase la Figura 6.4.7 siguiente. Para mover la imagen en la pantalla principal, haga 
clic y mantenga presionado el botón izquierdo sobre la imagen, y mueva el ratón. 
 

 Tenga en cuenta que, tradicionalmente, esta función también se denomina «Vista 
panorámica» o «Pan and Scan». 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Para asegurarse de que el espécimen esté a la vista, el botón Fit to 
Specimen (Ajustar al espécimen) intentará detectar y ampliar el 
espécimen. Si no se detecta un espécimen, este se ajustará por defecto 
al modo anterior (ya sea «Fit to Screen» [Ajustar a la pantalla] o «Zoom 
1.0x»). 
 
Fit to Screen (Ajustar a la pantalla) ajustará la imagen a la pantalla. 
 
Tradicionalmente, Zoom 1.0x se denomina «resolución completa»,  
ya que lleva la imagen a una vista 1-1 con la resolución del monitor. 
 
 
 

Anotaciones 
 
El botón mostrado en la Figura 6.4.8 abrirá las herramientas de anotación.  
Estas herramientas y sus numerosas funciones se tratan con más detalle en la 
Sección 6.8.0. 
 

 6.4.1 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.4.5 
Icono de la herramienta Zoom 
 
 
 
Figura 6.4.6 
Herramienta Zoom Level 
Adjustment (Ajuste del nivel 
de zoom) 
 
 
Figura 6.4.7 
Ejemplo de vista panorámica 
(izquierda) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 6.4.8  
Icono de Anotaciones 
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Almacenar en SACI 
El botón mostrado en la Figura 6.4.9 solamente funcionará cuando el sistema esté 
instalado en un centro médico con una red SACI. Para guardar sus archivos 
localmente, consulte la sección 6.7.0. 
 
 

Impresión en SACI 
El botón mostrado en la Figura 6.4.10 solamente funcionará cuando el sistema esté 
instalado en un centro médico con una red SACI. Para efectuar la impresión local, 
consulte la sección 6.7.0. 
 
 

Panel de control del dispositivo 

El botón mostrado en la Figura 6.4.11 abrirá el panel de control del dispositivo, lo 
que ofrecerá al usuario del dispositivo la oportunidad de controlar el sistema de 
rayos X mediante el software. El usuario podrá seleccionar fácilmente el modo de 
exposición, el ajuste de kV del tubo de rayos X, el tiempo de exposición y el número 
de imágenes que deberán obtenerse para el promediado de las imágenes (si lo desea), así 
como iniciar la exposición a los rayos X. 
 
 

 NOTA: El estado o la disponibilidad de los ajustes 
de la exposición se indica mediante las flechas arriba y 
abajo adyacentes al ajuste. Las flechas serán blancas 
para los ajustes activos y celestes para los inactivos. 
Los ajustes de la exposición que estén activos 
dependerán del modo de exposición seleccionado. 
 
La Figura 6.4.12 de la derecha muestra que se ha 
seleccionado el modo manual completo y que los 
promedios de kV, tiempo e imagen están todos activos. 
El usuario podrá ajustar cada una de estas 
configuraciones.  
 
 
 
 
 

 Tenga en cuenta que, en el sistema Faxitron Core, 
la configuración de mA no se puede ajustar utilizando 
el software y siempre estará inactivo. 
 
 
 
 
 
Cuando termine, haga clic en el botón Request X-Rays 
(Solicitar rayos X) para adquirir una imagen o en el 
botón Set (Ajustar) para guardar la configuración y 
cerrar el panel de control del dispositivo. 
 
Si se hace clic en el botón Cancel (Cancelar), el panel 
de control del dispositivo se cerrará sin guardar ninguno de los cambios. 
 
 

 6.4.1 Cont.  
 
Figura 6.4.9  
Icono de Guardar en SACI  
 
 
 
Figura 6.4.10  
Icono de Impresión en SACI  
 
 
 
 
Figura 6.4.11 
Icono del Panel de control del 
dispositivo 
 
 
 
 
Figura 6.4.12 
Panel de control del dispositivo 
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Volver al procedimiento 

El botón mostrado en la Figura 6.4.13 cierra el modo de obtención de imágenes y 
regresa a la pantalla del Home Menu (Menú de inicio). 

 

Apagado 
El botón mostrado en la Figura 6.4.14 cierra el software y apaga el ordenador. 

 

 

Notas de diálogo adicionales 
Cuando se abre un diálogo, este se «acopla» a la izquierda de la pantalla. Si un usuario desea 
desacoplar el cuadro de diálogo, podrá hacer clic en el icono de «anclaje» superior derecho 
para desacoplar el cuadro de diálogo y poder arrastrarlo libremente. El «anclaje» se convertirá 
luego en un icono «X», que permitirá el cierre rápido. 

Los usuarios también pueden navegar rápidamente entre los distintos diálogos haciendo clic 
en el menú de la izquierda. Al hacerlo, el menú de la izquierda se cerrará rápidamente y abrirá 
los cuadros de diálogo correspondientes, según sea necesario. 

 

 

 
Barra de menú superior 

El software permite acceder a los menús «View» (Ver), «Tools» (Herramientas), «Image Tools» 
(Herramientas de imagen), «DICOM Utilities» (Utilidades de DICOM) y «Help» (Ayuda) 
mediante una barra de menús superior. Véase la Figura 6.4.15. La barra de menú superior está 
oculta de forma predeterminada y se muestra haciendo clic en el botón de flecha ubicado en 
la esquina superior derecha de la pantalla. Véase la Figura 6.4.16. El botón de flecha será 
blanco o negro, dependiendo de la página del software o el fondo de pantalla. Cada elemento 
del menú se tratará en detalle en las páginas siguientes. 

 
 

 Nota: La flecha apuntará hacia abajo cuando la barra de menú 
superior esté oculta y, hacia arriba, cuando esta se muestre. 
 

 
Menú View (Ver) 

El menú «View» (Ver) se encuentra en el menú principal superior y contiene los elementos del 
submenú mostrados en la Figura 6.4.17 siguiente. Cada una de estas opciones se describirá 
con más detalle en las próximas páginas. 
 
 
 
 
 
 
 
 
 
 

 6.4.1 Cont.  
 
Figura 6.4.13  
Icono de regreso al menú  
de inicio 
 
 

Figura 6.4.14 
Icono de apagado del sistema 
 
 
 
 
 
 
 
 
 
 
 

6.4.2 
Barra de menú 
superior 
 
 
 
 
 
 
 
Figura 6.4.15  
Barra de menú superior 

Figura 6.4.16  
Botones de la barra de menú 
superior 
 
 
6.4.3 
Menú View (Ver) 
 
 

Figura 6.4.17  
Menú View (Ver) 
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Modo Zoom 
 

Normal 
Muestra la imagen obtenida en su formato original. El formato nativo de la imagen de Faxitron 
Core se ajusta al área de visualización del monitor. El usuario puede ampliar la imagen si lo 
desea. Consulte Ajuste del zoom dinámico en la sección 6.4.1.  
 

Adjust Zoom (Ajustar el zoom) 
Esta opción está desactivada y no está disponible en este momento. 
 

Fit to Sample (Ajustar al espécimen) 
Esta opción adapta la imagen obtenida para que se ajuste mejor a la muestra de especímenes 
dentro del área de visualización del monitor. 

 
Fit All (Ajustar todos) 

Esta opción muestra toda la imagen obtenida, independientemente de cuál sea su formato 
original. La opción Full Resolution (Resolución completa) no funciona en este modo de vista.  
 

Fit Width (Ajustar anchura) 
Esta opción muestra la imagen obtenida a lo largo del ancho disponible de toda el área de 
visualización. 
 

Ajustar altura (Ajustar altura) 
Esta opción muestra la imagen obtenida a lo largo de la altura disponible de toda el área de 
visualización.  
 

Image Averages (Promedios entre las imágenes) 
Esta opción permite al usuario ajustar el número de promedios entre las imágenes que se 
tomarán por cada exposición. Las opciones disponibles son las tomas 1x, 2x, 4x u 8x. El ajuste 
predeterminado es la toma 1x. Si el usuario selecciona 2, 4 u 8 tomas, el software obtendrá el 
número de imágenes seleccionadas una detrás de otra pulsando el botón Start (Comenzar) 
una sola vez y promediará esas imágenes en una sola imagen. 
 

Image Perspective (Perspectiva de la imagen) 
Esta opción permite al usuario rotar la imagen visualizada a una orientación de 0, 90, 180 y  
270 grados. 
 

 6.4.3 Cont. 
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Grid Options (Opciones de cuadrícula) 
Cuando se muestra una imagen, ya sea como una imagen obtenida o una imagen recuperada 
de la base de datos, el usuario podrá activar una cuadrícula. También permite al usuario 
establecer el espaciado (anchura) de la cuadrícula. Véase el ejemplo siguiente. 

User Window Levels (Niveles de la ventana de usuario) 
Esto permite al usuario definir hasta tres (3) niveles de la ventana (WL) prefijados y establecidos 
por el usuario. En primer lugar, seleccione el botón Window Level (Nivel de la ventana) y ajuste 
el WL al nivel deseado. En el menú «View» (Ver), seleccione «User Window Levels» (Niveles de 
ventana de usuario). Seleccione «Record Current WL» (Registrar WL actual) como USUARIO 
WL n.º 1, n.º 2 o n.º 3. El WL ajustado se guardará según la opción seleccionada previamente. 

Default Window Level (Nivel predeterminado de la ventana) 
El usuario tiene dos opciones de «Default Window Levels» (Niveles predeterminados de la 
ventana) (WL): «Optimize for whole area» (Optimizar para toda el área), que ajusta el WL para 
toda la imagen, u «Optimize for sample» (Optimizar para el espécimen), que ajusta el WL 
solamente para el área del espécimen. Además, existe la opción «Set Default Window Level» 
(Establecer el nivel predeterminado de la ventana), que se utiliza también para todas las 
imágenes obtenidas que se encuentran aquí. Esta establecerá el nivel predeterminado de la 
ventana en función de las estadísticas de la imagen y deberá hacerse por separado para las 
imágenes no mejoradas y las mejoradas. 

Default Aspect of Raw Files  
(Aspecto predeterminado de los archivos sin procesar) 

Ayuda a importar y abrir archivos de imágenes previamente guardados con atributos de archivo 
desconocidos o datos de imágenes binarios que no tienen ninguna información de encabezado. 
Dado que el tamaño exacto del conjunto del generador de imágenes no está disponible en el 
encabezado del archivo de datos de imagen, se usarán las dimensiones del generador de 
imágenes más adecuadas para importar o abrir dichas imágenes en función de que el ancho 
sea mayor o menor que la altura (información de aspecto predeterminada). 

Enhance Image (same as the Enhance Image button)  
(Mejorar la imagen [igual que el botón Mejorar la imagen]) 

Procesa la imagen actual del paciente y mejora la visualización del tejido situado cerca de la 
periferia de la muestra. 

Sample Viewer (Visor de muestras) 
La vista de muestras alterna un visor de cámara web para facilitar la alineación de los 
especímenes. No se puede añadir una cámara web al sistema Faxitron Core. 

 6.4.3 Cont. 
 
 
 
Figura 6.4.18 
Visualización de la cuadrícula de 
la muestra 
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Magnifier Size (Tamaño de la lupa) 
Permite al usuario seleccionar el tamaño de la herramienta Magnifier (Lupa) (véase el menú 
Image Tools [Herramientas de imagen]). Las opciones son «Small» (Pequeña), «Medium» 
(Mediana) y «Large» (Grande).  

Review Layout (Disposición de la revisión) 
Ayuda al usuario a configurar múltiples paneles de imagen en Review (Database) Mode (Modo 
de revisión [de la base de datos]) del programa. Las opciones de disposición disponibles son: 
«(1 X 1) Single» (Simple), «(2 X 1) Double H» (Doble H), «(1 X 2) Double V» (Doble V), «(1 + 
(2 X 1) Triple» y «(2 X 2) Quadruple» (Cuádruple). Durante la operación con paneles múltiples, 
el usuario puede hacer clic una vez en el panel o la imagen deseada para realizar la selección 
actual; el panel seleccionado actual tendrá un borde rectangular verde alrededor. Las imágenes 
incluidas en la vista de lista de la base de datos, o vista de miniaturas de la base de datos, se 
abrirán en el panel seleccionado actual cuando se haga doble clic sobre ellas. El usuario 
también podrá abrir las imágenes en los paneles deseados directamente desde el menú 
contextual de las vistas de la base de datos mencionada. Después de activar el menú 
contextual, el usuario podrá seleccionar en los paneles listados bajo OPEN TO→ (ABRIR
HACIA) que proporcionará los paneles disponibles para abrir la imagen (izquierda, derecha, 
arriba, abajo, etc.). 

Menú Tools (Herramientas) 
El menú «Tools» (Herramientas) está ubicado en la barra de menú superior, situada en la 
esquina superior izquierda de la pantalla principal. 

Preferences (Preferencias) 
El menú «Preferences» (Preferencias) abre una utilidad de gestión de la configuración que 
permite cambiar varias opciones o parámetros.  

 NOTA: La herramienta «Preferences» (Preferencias) está protegida mediante contraseña 
y solamente puede acceder a ella un representante autorizado del servicio técnico de Hologic. 

 NOTA: Cambiar los parámetros de configuración sin los conocimientos ni la autorización 
pertinentes podrá causar la pérdida de calidad de las imágenes, daños en el sistema y 
funcionamiento incorrecto del sistema. 

Modo Service (Modo de mantenimiento) 
El «Service Mode» (Modo de mantenimiento) está protegido mediante contraseña y lo activan 
técnicos autorizados de Hologic para resolver problemas.  

Service Tools (Herramientas de mantenimiento) 
«Service Tools» (Herramientas de mantenimiento) suelen aparecer sombreadas en gris. 
Solamente se enciende cuando el sistema está en «Service Mode» (Modo de mantenimiento). 

6.4.3 Cont. 

6.4.4 
Menú Tools 
(Herramientas) 
Figura 6.4.19  
Menú Tools (Heramientas) 
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Save Reference Files (Guardar archivos de referencia) 
La opción «Save Reference Files» (Guardar archivos de referencia) suele aparecer sombreada 
en gris. Solamente se enciende cuando el sistema está en «Service Mode» (Modo de 
mantenimiento). 

 
 

Advanced Tools Options (Opciones de herramientas avanzadas) 
Las «Advanced Tools» (Herramientas avanzadas) ofrecen varias opciones para configurar 
aspectos del software tales como el postprocesamiento y las opciones de configuración. 
 
Auto Save On/Off (Guardar el encendido y apagado automático) 

Cuando «Auto save» (Guardar automáticamente) está «activado», todas las imágenes 
obtenidas posteriormente se guardarán en la base de datos. Los archivos se escribirán en un 
directorio de datos definido en el archivo de configuración. 
 

X-Ray Calibration/Exposure Set-up  
(Calibración de los rayos X/Configuración de la exposición) 

Se encuentran en Advanced Tools (Herramientas avanzadas). «X-Ray Calibration/Exposure 
Setup» (Calibración de los rayos X/Configuración de la exposición) ayuda al usuario a 
determinar el tiempo de exposición adecuado para un determinado ajuste de kV que obtenga 
la mejor calidad de las imágenes. Consulte en la sección 6.2.0 y la Figura 6.2.4 una descripción 
más detallada. 
 

Configuración del CAE de la exposición de una toma previa 
El sistema Faxitron Core utiliza el control automático de la exposición (CAE) para proporcionar 
la mejor calidad posible de las imágenes pulsando el botón Start X-Ray (Comenzar radiografía) 
una sola vez. El software utilizará una exposición de una Preshot (Toma previa) para calcular 
los ajustes óptimos de la exposición en kV y tiempo. La toma previa es una exposición breve a 
los rayos X, normalmente de 2 a 3 segundos. El software analizará los resultados para 
determinar el kV y el tiempo necesarios para producir la mejor calidad de las imágenes. La 
exposición al CAE de una toma previa se configura en fábrica y se activa de forma 
predeterminada.  

«Preshot AEC Exposure Setup» (Configuración del CAE de la exposición de una toma previa) 
permite al usuario ajustar el sistema a determinados requisitos de obtención de imágenes o 
para compensar el envejecimiento del sistema. 
Para acceder al cuadro de diálogo «Preshot AEC Exposure Setup» (Configuración del CAE de 
la exposición de una toma previa), vaya a la barra de menú superior, seleccione «Tools» 
(Herramientas), «Advanced Tools» (Herramientas avanzadas) y, a continuación, «PRESHOT 
AEC Exposure Setup» (Configuración del CAE de la exposición de una toma previa). Véase la 
Figura 6.4.19. Se abrirá el cuadro de diálogo de configuración del CAE de la toma previa 
mostrado en la Figura 6.4.20. 
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Introduzca los valores de 
PRESHOT AEC (CAE DE LA 
TOMA PREVIA) en la ventana 
que se muestra a la derecha. 

Para el ajuste de las tomas 
previas, los ajustes mostrados 
reflejan un tiempo de exposición 
de 23 kV y 2 segundos con una 
intensidad objetivo de 
8000 UAD. Los usuarios pueden 
introducir los parámetros de las 
tomas previas solo cuando se 
selecciona DYNAMIC METHOD 
(MÉTODO DINÁMICO) (en la 
sección PRESHOT ANALYSYS 
METHOD [MÉTODO DE 
ANÁLISIS DE TOMAS 
PREVIAS]). La selección de 
STATIC METHOD (MÉTODO 
ESTÁTICO) utilizará parámetros 
predefinidos por Hologic. 
Además, el usuario tendrá la 
opción de seleccionar los 
ajustes de kV y tiempo de 
exposición en la sección 
EXPOSURE TUNING METHOD 
(MÉTODO DE AJUSTE DE LA 
EXPOSICIÓN).  

Para obtener unas imágenes 
más precisas, el usuario podrá 
introducir el grosor de SOFT 
TISSUE (Sample) (TEJIDO 
BLANDO [Muestra]) y TARGET INTENSITY (INTENSIDAD DEL OBJETIVO) en las UAD.  

 Nota: Los valores mostrados están dentro del rango típico de un sistema Faxitron Core, 
pero pueden variar. 

Para el modo AUTOMATIC EXPOSURE CONTROL (CONTROL DE LA EXPOSICIÓN 
AUTOMÁTICA), pulse el botón Start (Comenzar) en el software Vision (o en el panel de 
control). Para crear una región de interés (ROI) y obtener los parámetros de exposición para la 
exposición óptima de la imagen, el software Vision realizará una toma previa (exposición previa 
a una dosis breve y baja) de la muestra. 

 
Login Utility (Utilidad de inicio de sesión) 

La Login Utility (Utilidad de inicio de 
sesión) está en el menú «Advanced 
Tools» (Herramientas avanzadas) y 
permite al usuario configurar y activar 
la autenticación con contraseña de 
inicio del software Vision. La 
activación de esta función es opcional 
en el sistema Faxitron Core. Si el 
usuario activa la autenticación con 
contraseña, se le pedirá la contraseña 
cada vez que abra el programa. Si no 
se introduce la contraseña correcta, el 
programa se cerrará. 

 6.4.4 Cont. 
 
Figura 6.4.20 
Preshot AEC Exposure Setup 
(Configuración del CAE de la 
exposición de una toma previa)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.4.21 
Login Utility (Utilidad de  
inicio de sesión) 
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Properties (Propiedades) 
«Properties» (Propiedades) oculta o muestra el cuadro de información de la imagen. Véase la 
Figura 6.3.9. 

Edit Current Image Record (Editar el registro de imagen actual) 
Actualmente no se utiliza. 

Delete Current Image Record (Eliminar registro de imagen actual) 
Elimina la imagen actual del directorio de archivos, tal y como se especifica en el archivo de 
configuración. 

Add Current Image Record (Agregar registro de la imagen actual) 
Añade la imagen actual al directorio de archivos, tal y como se especifica en el archivo de 
configuración. 

Capture Screen Shot JPG/BMP  
(Realizar captura de pantalla en JPG/BMP) 

Seleccionando esta opción del menú, el usuario puede realizar una captura de pantalla de la 
ventana activa mostrada. El usuario puede especificar un nombre de archivo y elegir entre JPG 
y BMP como formato de archivo guardado. 

Save / Store Current Image  
(Guardar o almacenar la imagen actual) 

El usuario puede «navegar» hasta el directorio o la carpeta de archivos en la que desee guardar 
la imagen. Deberá asignarse un nombre de fichero en el campo proporcionado. El usuario 
puede guardar la imagen como un tipo de archivo BMP, JPEG, TIF, RAW o DICOM. Para 
guardar el archivo en formato DICOM, consulte la sección «DICOM Functionality» 
(Funcionalidad DICOM). 

Print Current Image (Imprimir imagen actual) 
Imprime la imagen actual en la impresora de Windows. 

 

Image Tools (Herramientas de imagen) 
Para editar la imagen obtenida o recuperada, están 
disponibles las siguientes funciones haciendo clic en el 
menú «Image Tools» (Herramientas de imagen). Véase la 
Figura 6.4.22. Con un solo clic del ratón sobre la opción 
deseada, se podrá acceder a o activar las opciones del 
submenú. 

 

 6.4.4 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.4.5 
Image Tools 
(Herramientas de 
imagen) 
 
 
Figura 6.4.22 
Menú Image Tools  
(Herramientas de imagen) 
 



 
 

MANUAL DE USUARIO DE FAXITRON CORE | HOLOGIC | REVISIÓN 001 
 

SECCIÓN 
Software 
Vision 6 

6 - 23 

Faxitron® Core 
Sistema de radiografía de muestras 
 

Original Contrast (Contraste original) 
«Original Contrast» (Contraste original) restaura los niveles de contraste de la imagen. Esto sirve 
para el mismo propósito que el botón Original Contrast (Contraste original) en la herramienta 
Window Level and Contrast (Nivel de la ventana y contraste). Véanse la sección 6.4.1 y la  
Figura 6.4.3. 

Invert (Invertir) 
«Invert» (Invertir) hace que la imagen visualizada se invierta o revierta. Al invertir una imagen, 
se invierte su transparencia: lo que es negro se convierte en blanco y lo que es blanco se 
convierte en negro. A los grises se les asigna su transparencia espejo. Para desactivar la 
función, haga clic de nuevo en «Invert» (Invertir). Realiza la misma función que el botón Invert 
(Invertir). Consulte la sección 6.4.1 y las Figuras 6.4.3 y 6.4.4. 

Magnify (Ampliar) 
«Magnify» (Ampliar) permite al usuario ampliar un área de interés. Para utilizar la función 
Magnify (Ampliar), sitúe el cursor del ratón sobre el área que desee ampliar y haga clic con el 
botón izquierdo del ratón. Se ampliará el área de interés. Para desactivar la función, haga clic 
de nuevo en «Magnify» (Ampliar). Consulte la Figura 6.4.23. El usuario podrá ajustar el tamaño 
del área de interés ampliada. Consulte el submenú «Magnifier Size» (Tamaño de la lupa) en la 
sección 6.4.3.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edge Enhance (Realce de los bordes) 
«Edge Enhance» (Realce de los bordes) definirá con mayor nitidez los bordes de las regiones 
utilizando una diferencia de contraste. Puede que el realce de los bordes amplifique el ruido en 
las imágenes en general. Seleccionando de nuevo la opción del menú, se desactivará el realce 
de bordes. Si hace clic en «Original Contrast» (Contraste original), la imagen volverá a su 
estado original. Tenga en cuenta que esta es una función diferente a la función Enhance Image 
(Mejorar la imagen) de las secciones 6.4.1 y 6.4.3. 

ROI Contrast (Contraste de la ROI) 
«ROI Contrast» (Contraste de la ROI) optimizará los niveles de contraste del interior de una 
región de interés (ROI) definida por el usuario. Después de seleccionar «ROI Contrast» 
(Contraste de la ROI), haga clic y mantenga pulsado el botón izquierdo del ratón en el punto 
inicial de la ROI deseada, arrastre el ratón y suelte el botón del ratón en el punto final de la ROI 
deseada. El contraste se ajustará automáticamente a los mejores niveles para esa ROI. 

ROI Window Level (Nivel de ventana de la ROI) 
La función «ROI Window Level» (Nivel de ventana de la ROI) no está disponible en la versión 
actual del software Vision. 

 6.4.5 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.4.23 
Ampliar 
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Ruler (Regla) 
«Ruler» (Regla) permite al usuario medir la distancia entre dos puntos de la imagen visualizada. 
Las medidas de longitud se expresan en milímetros (mm). Después de seleccionar «Ruler» 
(Regla), haga clic y mantenga pulsado el botón izquierdo del ratón y, empezando por el punto 
inicial de la medición, arrastre el ratón y suelte el botón del ratón en el punto final de la medición. 
En la imagen, la regla tiene el aspecto de una línea roja. 
 
La medición (en mm) se muestra 
al final de la regla. Hasta que el 
usuario seleccione otra 
herramienta de imagen o hasta 
que se realice otra acción, la regla 
permanecerá activa. Véase la 
Figura 6.4.24. Para desactivar la 
función, haga clic de nuevo en 
«Ruler» (Regla). 
 
Sugerencia: Para obtener una 
regla perfectamente horizontal, 
vertical o de 45 grados, mantenga 
pulsada la tecla SHIFT (del 
teclado) mientras mantiene 
pulsado el botón izquierdo del 
ratón y arrastre. 
 
 

ROI Statistics (Estadísticas de la ROI) 
«ROI Statistics» (Estadísticas de la ROI) mostrará un cuadro de diálogo que contiene 
estadísticas de la imagen. Haga clic y mantenga presionado el botón izquierdo del ratón sobre 
la región de interés (ROI) de la imagen principal, arrastre el cursor para hacer la selección 
alrededor del área y luego suelte el botón del ratón. La información estadística de la región 
seleccionada se mostrará en el lado izquierdo del cuadro de diálogo y la de toda la imagen, en 
el lado derecho del recuadro. Las estadísticas que se muestran son: los puntos inicial y final de 
la ROI, los valores de intensidad Minimum (Mínimo), Maximum (Máximo) y Mean (Medio) y 
Standard Deviation (Desviación estándar) (STD). Para cerrar el cuadro de información Statistics 
(Estadística), simplemente haga clic en el botón Close (Cerrar). Véase la Figura 6.4.25. Para 
desactivar la función, haga clic de nuevo en «ROI Statistics» (Estadísticas de la ROI). 

 
 

 6.4.5 Cont. 
 
 
 
 
 
Figura 6.4.24 
Regla 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.4.25 
ROI Statistics  
(Estadísticas de la ROI) 
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ROI Histogram (Histograma de la ROI) 
«ROI Histogram» (Histograma de la ROI) creará un histograma para una ROI definida por el 
usuario. Después de seleccionar la opción del menú, coloque el cursor del ratón en la imagen 
visualizada, mantenga pulsado el botón izquierdo del ratón y arrástrelo para seleccionar la 
ROI deseada. Suelte el botón del ratón. Se mostrarán histogramas de la ROI seleccionada. 
Véase la Figura 6.4.26. 

La curva negra es el histograma de la región seleccionada. La curva azul es el histograma 
de toda la imagen. Ambas curvas se normalizan contra el valor máximo de píxeles de la 
región de interés seleccionada. Para desactivar la función, haga clic de nuevo en «ROI 
Histogram» (Histograma de la ROI). 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

ROI Profile (Perfil de la ROI) 
«ROI Profile» (Perfil de la ROI) creará un perfil para una ROI definida por el usuario. Después 
de seleccionar la opción del menú, coloque el cursor en la imagen visualizada. Para dibujar 
un cuadro definido por el usuario alrededor de la ROI deseada, mantenga pulsado el botón 
izquierdo del ratón y mueva el cursor por la imagen. Suelte el botón izquierdo del ratón  
y aparecerá un perfil que mostrará los valores de cada píxel de la ROI definida. Véase la 
Figura 6.4.27. Por defecto, la dirección de la promediación de la ROI seleccionada es el eje 
corto. El eje puede desplazarse hacia adelante y hacia atrás seleccionando el botón 
SWITCH, HOR<->VERT (CAMBIAR HORIZONTAL<->VERTICAL). Para desactivar la 
función, haga clic de nuevo en «ROI Profile» (Perfil de la ROI). 
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Figura 6.4.26 
ROI Histogram  
(Histograma de la ROI) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.4.27 
ROI Profile (Perfil de la ROI) 
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Line Profile (Perfil de la línea) 
«Line Profile» (Perfil de la línea) mostrará el perfil de una línea definida por el usuario. 
Después de seleccionar «Line Profile» (Perfil de la línea), coloque el cursor en la imagen 
visualizada. Para dibujar una línea definida por el usuario, mantenga pulsado el botón 
izquierdo del ratón y mueva el cursor por la imagen. Suelte el botón izquierdo del ratón y 
aparecerá un perfil que mostrará los valores de cada píxel de la línea definida. Véase la 
Figura 6.4.28. Por defecto, el primer punto seleccionado es siempre la parte izquierda (más 
cercana al origen) del gráfico (es decir, el eje horizontal del gráfico puede tener índices de 
píxeles (i, j) crecientes o decrecientes, dependiendo de los puntos inicial o final que se hayan 
seleccionado). Para desactivar la función, haga clic de nuevo en «Line Profile» (Perfil de la 
línea). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Built-In Window Level (Nivel de ventana incorporado) 
El software Vision viene con una función de Window Level (Nivel de ventana) «incorporado». 
Para seleccionarlo, no hay ningún botón ni elemento del menú. La función Window Level 
(Nivel de ventana) se activa automáticamente cada vez que se obtiene una imagen o se 
recupera de la base de datos para revisarla. Esta función permite al usuario ajustar los 
niveles de contraste y brillo de la imagen utilizando el ratón o el cursor. 

Para ver los niveles de brillo u oscuridad, haga clic y mantenga pulsado el botón izquierdo 
del ratón sobre la imagen visualizada y mueva el cursor hacia arriba y hacia abajo. O mueva 
el cursor hacia la izquierda y hacia la derecha para obtener un contraste alto o bajo. Mueva 
el cursor hasta que la imagen se encuentre en los niveles deseados. 
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Figura 6.4.28 
Line Profile (Perfil de la línea) 
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Presionando el botón mostrado en la Figura 6.5.1 y ubicado en la parte inferior de la ventana 
de obtención de imágenes, aparecerá la secuencia de imágenes en miniatura del paciente 
actual. Véase la Figura 6.5.2. 
 
 
 
 
 
 
 

 
 

 

En texto naranja y a lo largo de la parte superior, la secuencia de miniaturas mostrará la 
fecha en la que se realizó el procedimiento de cada serie de imágenes individuales. 

Se iluminará en verde la imagen actual que aparece mostrada en la ventana de obtención 
de imágenes. 

Para colocar las imágenes en la pantalla o en los paneles de revisión, la secuencia de 
miniaturas permite realizar las operaciones «arrastrar» y «soltar», según sea necesario. 

Además, con un solo clic, el usuario podrá seleccionar varias imágenes y, a continuación, 
seleccionar entre las diferentes opciones para guardar las imágenes en una unidad USB, 
enviar las imágenes al SACI o borrar las imágenes. Las imágenes seleccionadas aparecerán 
resaltadas en naranja. 

Hay flechas situadas a la izquierda y a la derecha. En caso de que se tomen gran cantidad 
de imágenes, pulsando las flechas izquierda o derecha el usuario podrá recorrer por fecha 
ascendente las imágenes tomadas. 

También hay una opción disponible para Open the Database (Abrir la base de datos) (véase 
la Figura 6.5.3), que entra en el modo Review (Revisión). Este mismo botón es el equivalente 
a pulsar Review Mode (Modo de revisión) en Home Menu (Menú de inicio). Véanse las 
Figuras 6.0.1 y 6.6.1. 

 

 6.5.0 
Explorador de 
imágenes del 
paciente actual 
Figura 6.5.1 
Icono del explorador de 
imágenes del paciente actual 
 

Figura 6.5.2 
Explorador de imágenes del 
paciente actual 
 
 
 
 
 
Figura 6.5.3 
Botón de la base de datos de 
las imágenes 
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Se puede entrar en el modo de revisión haciendo clic en el botón Review (Revisar) de la 
página Home Menu (Menú de inicio), Figuras 6.6.1 y 6.0.1, o en el botón Open Database 
(Abrir base de datos) de Current Image Browser (Explorador de 
imágenes actuales). Véase la Figura 6.5.3 anterior. Al hacer clic en 
cualquiera de estos botones, se abrirá la base de datos como se muestra 
en la Figura 6.6.2. Mientras esté en modo de revisión, el sistema estará 
en modo de espera.  
 
 
La base de datos se compone básicamente de tres secciones o subventanas. La sección 
Patient List Table (Tabla de la lista de pacientes) en la parte superior, la sección Procedure 
List Table (Tabla de la lista de procedimientos) en el centro y la sección Image Thumbnail 
List/Viewer (Lista/Visor de imágenes en miniatura) en la parte inferior.  

 6.6.0 
Base de datos 
Figura 6.6.1  
Icono del modo de revisión 
que aparece en el menú  
de inicio  
 
 
 
 
 
Figura 6.6.2 
Base de datos de las 
imágenes 
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Como indica la flecha, las tablas de listas funcionan en una jerarquía de arriba hacia abajo: 
The Patient List (Lista de pacientes) ---> Procedure List (Lista de procedimientos) ---> Image 
Thumbnail List/Viewer (Lista/Visor de imágenes en miniatura). 
Cuando se selecciona un campo Patient (Paciente), se activa la ventana Procedure 
(Procedimiento). La ventana Procedure (Procedimiento) muestra una lista de todos los 
procedimientos realizados en el paciente seleccionado. Además, todas las imágenes 
correspondientes al paciente se mostrarán en la parte inferior derecha.  
Cuando se selecciona un procedimiento, la lista de imágenes en miniatura/visor se filtrará para 
mostrar solamente las imágenes que corresponden al procedimiento seleccionado. Se pueden 
seleccionar varios procedimientos manteniendo pulsada la tecla Mayúsculas y haciendo clic 
con el botón izquierdo del ratón en cada procedimiento. Se mostrarán las imágenes 
correspondientes de los procedimientos seleccionados. 
Puede ajustarse la elección en la base de datos haciendo clic en los campos superiores, como 
Patient ID (Identificación de paciente) y Last Name (Apellido), para ordenarla por uno u otro 
campo. Cuando se haga clic con el cursor del ratón sobre uno de los campos de la base de datos, 
se mostrará un pequeño indicador de flecha dentro del campo. Usando el botón izquierdo del 
ratón y seleccionando el campo de nuevo, la flecha cambiará de ascendente a descendente o 
viceversa. El campo seleccionado correspondiente se ordenará automáticamente. 
Para facilitar la navegación, hay barras de desplazamiento en la base de datos. 
Para añadir automáticamente la imagen a un panel de revisión, la lista de miniaturas/visor 
permite al usuario hacer clic en el símbolo «+». Un usuario puede añadir hasta cuatro 
imágenes en los paneles de revisión. Los paneles de revisión se ajustarán automáticamente 
para abarcar las cuatro imágenes. 
Todas las opciones del Current Patient Images Browser (Explorador de imágenes del paciente 
actual) (véase la Figura 6.5.2) están también disponibles en la parte superior de la página 
Database (Base de datos). Además, en la sección 6.6.1 se describen opciones adicionales. 
Nota importante: Las imágenes en miniatura (.PNG) son archivos independientes de los 
archivos de datos de imagen reales (DCM, DAT, DMM o RAW). Tienen el mismo nombre de 
archivo que el archivo de imagen, pero tienen una extensión de archivo (.PNG). Es posible 
tener un archivo de imagen sin «miniatura». En ese caso, Vision intentará crear una miniatura 
automáticamente para que la imagen se cargue en la base de datos. Sin embargo, si esto no 
se pudiera hacer, la imagen no se mostrará. 
 

Save Image(s) (Guardar imágenes) 
El botón Save Image(s) (Guardar imágenes) aparece al seleccionar una entrada de Image 
Table (Tabla de imágenes) o Thumbnail List (Lista de imágenes en miniatura), o en las 
imágenes del paciente actuales; de lo contrario, se desactivará. La imagen seleccionada se 
podrá guardar en los siguientes formatos de imagen de 8 bits: JPEG, BMP, TIFF y RAW. 
También se podrá guardar en formato TIFF de 16 bits. 
El nivel de ventana de la imagen guardada es el nivel de ventana predeterminado. Si el usuario 
requiere que el nivel de la ventana esté organizado, deberá cargar la imagen en Image View 
(Vista de imagen) e imprimir desde allí, en lugar de imprimir desde el cuadro de diálogo de la 
base de datos. 
 

Send Image(s) to PACS (Enviar imágenes al SACI): 
Esta función envía las imágenes a un servidor SACI de DICOM preconfigurado. Para obtener 
más información, consulte la sección 6.7.0.  
 

Funciones y herramientas del menú de la 
base de datos o de imágenes 

Hay funciones para explorar y buscar en la base de datos, 
así como para editar, borrar y añadir registros a la base de 
datos. Estas funciones se explican a lo largo de los 
elementos del menú de la base de datos. Se accede a ellas 
desde el botón de nivel superior denominado Additional 
Options (Opciones adicionales) dentro de la base de datos. 

 6.6.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.6.1 
Opciones 
adicionales de la 
base de datos 
 
Figura 6.6.3 
Menú Additional Options  
(Opciones adicionales) 
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Menú Open (Abrir) 
El menú «Open» (Abrir) solamente tiene una opción «Open Image from File» (Abrir imagen 
desde archivo) que abre un cuadro de diálogo de Windows que permite al usuario navegar y 
abrir archivos de imagen ubicados en unidades locales o de red. 

Menú Print (Imprimir) 
El menú «DB-Print» (Imprimir 
base de datos) ofrece la función 
de impresión de imágenes, 
procedimientos o pacientes. 
Véase la Figura 6.6.4. 
 
 
 
 
 
Print Image to Local Printer (Imprimir imagen en la impresora local) 
«Print Image to Local Printer» (Imprimir imagen en la impresora local) está disponible cuando 
se selecciona la entrada en la tabla de imágenes o en la lista de imágenes en miniatura; de lo 
contrario, estará desactivada. La imagen seleccionada se imprimirá utilizando la impresora 
local predeterminada del sistema Windows. 
El nivel de ventana de la imagen impresa es el nivel de ventana predeterminado. No se 
recomienda que los usuarios impriman desde este menú, a menos que estén satisfechos con 
las impresiones establecidas en los niveles de ventana predeterminados y calculados por el 
programa. El usuario podrá cargar la imagen primero en la ventana Image View (Review) (Vista 
de imagen [Revisión]) y luego ajustar la imagen a los niveles de ventana deseados. Cuando 
esté satisfecho con el nivel de la ventana, el usuario podrá iniciar la impresión desde el menú 
de la ventana de Image View (Vista de imagen). El cuadro de diálogo Format Options 
(Opciones de formato) ofrece la posibilidad de elegir entre formatos de impresión. 

Print Image(s) to DCM Printer  
(Imprimir imágenes en una impresora DCM) 

Esta función envía las imágenes a una impresora DICOM preconfigurada. 

Menú View (Ver) 
El menú «View» (Ver) ofrece al 
usuario una serie de opciones 
que afectan a la vista de la base 
de datos. Véase la Figura 6.6.5. 

 
 
 
 
 
 
 
Show All DB Entries (Mostrar todas las entradas de la base de datos) 
Recarga la tabla de pacientes desde el archivo de base de datos. Cualquier cambio o adición a 
la base de datos se aplicará a la tabla. Esta selección también borrará cualquier Search Filter 
(Filtro de búsqueda) activo que se haya aplicado a las tablas. Search Filter (Filtro de búsqueda) 
se explica a continuación en detalle en el tema Database Search (Búsqueda en la base de datos). 

Refresh DB Entries (Actualizar entradas de la base de datos) 
Actualiza la tabla Patient (Paciente), pero mantiene cualquier filtro de búsqueda existente que 
se haya aplicado. 

 6.6.1 Cont. 
 
 
 
 
 

Figura 6.6.4 
Menú Print (Impresión)  
de la base de datos 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.6.5 
Menú View (Ver) base de datos 
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Browse Data Directory (No DB) (Explorar el directorio de datos 
[no la base de datos]) 

Muestra todas las imágenes en miniatura en el directorio Data (Datos) establecido por el 
archivo de configuración. Estos archivos se muestran en el Visor de miniaturas. No están 
asociados a la base de datos ni a las listas de tablas. Esta herramienta es útil para revisar 
imágenes no grabadas o para depurar problemas de la base de datos con imágenes en el 
directorio de datos actual. 

Browse Any Directory (No DB) (Explorar cualquier directorio [no 
la base de datos]) 

Permite al usuario navegar a cualquier directorio de archivos. Estos archivos se muestran en 
el Visor de miniaturas. No están asociados a la base de datos ni a las listas de tablas. Esta 
herramienta es útil para revisar un directorio de imágenes, que nunca fue grabado en la base 
de datos, o cuando los registros de la base de datos están dañados. 

Search Menu (Menú de búsqueda) 
Las herramientas de «Search» (Búsqueda) de la base de datos, véase la Figura 6.6.6, 
proporcionan búsquedas detalladas o filtrado de la base de datos. Seleccionando el menú 
«DB-Search» (Búsqueda en la base de datos) el usuario puede realizar una búsqueda 
detallada y específica. Cuando se introducen y activan los criterios de búsqueda en el cuadro 
de diálogo de búsqueda de la base de datos, véase la Figura 6.6.7, el filtro de búsqueda se 
aplicará a todas las tablas de listas del cuadro de diálogo de la base de datos de imágenes. El 
criterio de búsqueda activado se denomina 
Search Filter (Filtro de búsqueda) y este filtro 
permanece efectivo hasta que el usuario 
selecciona «Stop Search» (Detener búsqueda) 
en el menú «DB-Search» (Búsqueda en la 
base de datos) o «Show all DB Entries» 
(Mostrar todas las entradas de la base de 
datos) en el menú «DB-View» (Vista de la base 
de datos). El filtro de búsqueda activo siempre 
se muestra en el título del cuadro de diálogo 
Image Database (Base de datos de imágenes). 

Start Search (Iniciar búsqueda) 
«Start Search» (Iniciar 
búsqueda) abre el 
diálogo de búsqueda de 
la base de datos que 
permite al usuario 
colocar un FILTRO DE 
BÚSQUEDA activo en la 
base de datos. Cuando 
se abre el diálogo de 
búsqueda, se cierra la página Database (Base de datos) y el software vuelve a la página Image 
Acquisition (Obtención de imágenes). La página Database (Base de datos) se reabrirá 
automáticamente después de cerrar el cuadro de diálogo Search (Buscar). 

 
Los menús desplegables proporcionan una lista de las categorías de búsqueda. Seleccione 
una categoría de búsqueda y escriba el parámetro de búsqueda deseado para iniciar la 
búsqueda. Para iniciar la búsqueda, seleccione «Start» (Comenzar). Si la categoría puede 
tener más de una entrada discreta, se mostrarán todas las entradas de esa categoría. 

Stop Search (Detener la búsqueda) 
«Stop Search» (Detener la búsqueda) desactiva cualquier filtro de búsqueda activo, borra todas 
las tablas de la lista y vuelve a cargar la lista de todos los pacientes a la tabla de lista de pacientes. 

 6.6.1 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 6.6.6 
Menú Search (Búsqueda)  
en la base de datos 
 
 
 
 
 
 
 
 
 

Figura 6.6.7 
Cómo iniciar una Búsqueda en la 
base de datos 
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Menú Tools (Herramientas) 
El menú «DB-Tools» ofrece funciones de imagen, procedimiento o paciente, así como algunas 
funciones útiles para reparar o reformatear la base de datos. 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Image Record (Editar registro de imagen) 
La función «Edit Image Record» (Editar registro de imagen) no está disponible actualmente en 
el software Vision. 

Add Record to DB (Añadir registro a la base de datos) 
Disponible cuando se selecciona la entrada de Image Table (Tabla de imágenes) o de 
Thumbnail List (Lista de imágenes en miniatura); de lo contrario, estará desactivada. Esto es 
especialmente útil cuando se navega por un directorio sin que la base de datos tenga entradas 
disponibles para las imágenes en ese directorio. El usuario puede seleccionar una sola imagen 
de la lista de miniaturas y añadir registros de esa imagen a la base de datos. Si la entrada de 
la base de datos ya existe para la imagen seleccionada, no causará ningún daño; solamente 
puede actualizar la base de datos en términos de dónde se encuentra actualmente el archivo 
de imagen, es decir, el nombre del archivo/carpeta.  

Import Records in DIR to DB (Importación de registros del 
directorio a la base de datos) 

Esta herramienta ayuda a buscar y seleccionar una carpeta y, a continuación, a rellenar la 
base de datos con todas las entradas correspondientes para todos los archivos de imagen del 
directorio seleccionado (incluidos los subdirectorios). Los formatos de las imágenes pueden 
ser DCM, DAT, DMM y RAW. Si faltan miniaturas de imágenes, esta herramienta también 
generará miniaturas de BMP en el mismo directorio. 

Reformat All DB (Reformatear toda la base de datos) 
La herramienta «Reformat All DB» (Reformatear toda la base de datos) ayuda a reformatear 
los campos Date [YYYY/MM/DD] (Fecha [AAAA/MM/DD]), Date/Time [YYYY/MM/DD 
HH:MM:SS] (Fecha/Hora [AAAA/MM/DD HH:MM:SS]) de las tablas, y también escribe en 
mayúsculas las letras de las entradas de algunos otros campos. Es una herramienta útil 
cuando algún archivo de base de datos más antiguo se importa y abre por primera vez, o 
cuando el usuario altera manualmente las entradas de la base de datos utilizando MS Access. 

 
Notas adicionales en la base de datos 

• La posibilidad de salir de la base de datos, permaneciendo dentro del modo Revisión,  
se encuentra en Additional Options (Opciones adicionales).  

• El botón de la parte superior izquierda se ajustará para llevar al usuario Back to Acquisition 
(De vuelta a la obtención), Back to the Main Menu (De vuelta al menú principal) o se convertirá 
en el botón Close Database (Cerrar base de datos), dependiendo del flujo de trabajo utilizado 
para entrar en la pantalla Database (Base de datos) y de lo que sea más conveniente. 

 6.6.1 Cont. 
 
 
Figura 6.6.8 
Menú Tools (Herramientas)  
de la base de datos 
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Editar o eliminar de la base de datos la información sobre el paciente 
El usuario puede editar o borrar la información sobre el paciente desde la base de datos. Para 
abrir un cuadro de diálogo, haga clic con el botón derecho en la entrada del paciente situada 
en la sección superior de la base de datos. Véase la Figura 6.6.9.  

 
Al hacer clic en «Edit Patient Information» (Editar 
información sobre el paciente), se abrirá un 
cuadro de diálogo «Patient Information» 
(Información sobre el paciente). Véase la Figura 
6.6.10. Para volver a la base de datos sin realizar 
ni guardar los cambios, haga clic en Cancel 
(Cancelar). Al hacer clic en Save Changes 
(Guardar cambios), se abrirá un cuadro de diálogo de «Confirmation» (Confirmación). Para 
confirmar y continuar, haga clic en Yes (Sí). Los cambios se guardarán y el usuario volverá a 
la base de datos. No anulará los cambios y volverá a la base de datos. Cancel (Cancelar) 
regresará al usuario al cuadro de diálogo «Patient Information» (Información sobre el paciente).  

 Nota: Si el sistema tiene activada una contraseña de puesta en marcha (consulte el tema Utilidad 
Inicio de sesión en la sección 6.4.4 y la Figura 6.4.21), se le pedirá la misma contraseña cuando 
intente «Delete Patient Information» (Eliminar la información sobre el paciente) en la base de datos. 
 

El estándar DICOM 
¿Qué es el estándar DICOM? 

El estándar de Imagenología Digital y Comunicaciones en Medicina (DICOM) es una serie de 
protocolos utilizados por equipos y software médicos para permitir que los datos sean 
compatibles e intercambiables con otros equipos o software médicos. 
Cuando se guarda un archivo en formato DICOM, se crea un archivo que incluye los datos 
relevantes del paciente, el equipo de obtención de imágenes, los datos del hardware y los datos 
de las imágenes, todo en un solo archivo. Además, el archivo guardado contiene características 
específicas identificadas por el ordenador y el software como archivo de estándar DICOM. Una 
vez que una aplicación de software reconoce el archivo como un archivo de estándar DICOM, 
puede iniciar un lector DICOM y extraer los datos correctamente, independientemente del 
origen del archivo. 
Un archivo creado utilizando el protocolo DICOM tiene la siguiente estructura: 

Cuando el preámbulo consta de 128 bytes, todos ellos normalmente configurados en 00H, a 
menos que no sean utilizados por un perfil de aplicación o una implementación específica; el 
prefijo consta de 4 bytes, que constituyen la cadena de caracteres «DICM» codificada como 
caracteres en mayúscula del repertorio de caracteres ISO 8859 G0; y los elementos de los 
datos son arbitrariamente grandes (o pequeños) y contienen los datos. 

 6.6.1 Cont. 
 
 
 
Figura 6.6.9 
Cuadro de diálogo Edit/Delete 
(Editar/Eliminar) (izquierda) 
 
Figura 6.6.10 
Patient Information (Información 
sobre el paciente) (derecha) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.7.0 
Funcionalidad 
DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.7.1 
Estructura del protocolo DICOM 
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Modalidad 
Para acceder a la configuración de la modalidad de los archivos DICOM, desde la barra de 
menús superior, seleccione «DICOM Utilities» (Utilidades DICOM) y, a continuación, «DICOM 
Modality Setup» (Configuración de la modalidad DICOM). 
 
 
 
 
 
 
Es posible seleccionar el tipo de almacenamiento DICOM, ya sea Presentation (Presentación) 
o Processing (Procesamiento). El mismo cuadro de diálogo permite seleccionar la modalidad 
de imagen DICOM, ya sea Digital X-Ray (Radiografías digitales) o Digital X-Ray Mammography 
(Mamografía digital de rayos X). El usuario no puede definir Transfer Syntax (Sintaxis de 
transferencia) ni Value Representation (Representación de valores). Siempre se asignan para 
que sean META HEADER PRESENT (con etiquetas meta en el encabezado), LITTLE_ENDIAN 
(extremidad pequeña) y VR_IMPLICIT (realidad virtual implícita). 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 NOTA: Cuando las modalidades DICOM se han seleccionado, permanecen en efecto 
incluso después de que el software Vision se ha cerrado. Los ajustes de modalidad 
se almacenarán y permanecerán en la forma configurada hasta que se cambien 
de nuevo utilizando DICOM File Settings (Ajustes del archivo DICOM). Estos 
ajustes (Storage Type & Modality, Transfer Syntax y Value Representation) (Tipo 
y modalidad de almacenamiento, sintaxis de transferencia y representación de 
valores) serán efectivos para todas las funcionalidades DICOM Local Save 
(Almacenamiento local) o Print (Impresión). 

 6.7.0 Cont. 
 
 

Figura 6.7.2 
Menú DICOM Utilities  
(Utilidades de DICOM) 
 
 
 
 
 
 
 

 
 
 
 

Figura 6.7.3 
Ajustes de la modalidad DICOM 
Se muestran los ajustes 
predeterminados 
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Default DICOM Servers (Servidores DICOM predeterminados) 
Esta sección contiene la configuración para los servidores DICOM predeterminados y para 
automatizar algunos de los procesos al almacenar, imprimir o buscar servidores SACI y MWL. 

Las casillas de verificación «Enable Single-Click Auto Store» (Activar almacenamiento 
automático con un solo clic), «Print» (Imprimir) o «MWL Connection» (Conexión MWL) permiten 
al usuario almacenar o imprimir imágenes, o conectarse automáticamente al servidor MWL. Si 
usted utiliza un solo servidor SACI para esas acciones o la mayoría de su trabajo involucra un 
solo servidor SACI, marque la casilla deseada para automatizar esas acciones. 

«Enable Auto Search When Connecting to MWL Server» (Habilitar la búsqueda automática al 
conectarse al servidor MWL) le indicará a la aplicación que realice automáticamente una 
búsqueda con la configuración de búsqueda predeterminada al buscar los datos del paciente. 

El cuadro de diálogo «Auto close dialog after N seconds of successful transfer/printing» (Cierre 
automático después de N segundos de transferencia o impresión correcta) cerrará 
automáticamente el cuadro de diálogo DICOM Networking (Trabajo en red DICOM) transcurrido 
un número especificado de segundos. Si hubo un error en la transferencia o la impresión, el 
diálogo no se cerrará automáticamente. 

Al hacer clic en el botón DICOM Servers (Servidores DICOM), se abrirá el cuadro de diálogo 
DICOM Networking (Trabajo en red DICOM), donde el usuario podrá añadir, modificar o 
eliminar servidores DICOM. Véase la Figura 6.7.5. 

DICOM Save Local (Guardar como DICOM local) 
Para guardar la imagen actual en una unidad local o directorio, haga clic con el botón derecho 
en cualquier parte de la imagen. Esto mostrará el cuadro de diálogo que se muestra en la 
Figura 6.7.4 siguiente. Haga clic en «Save/Store current imaddge» (Guardar/almacenar imagen 
actual) y, a continuación, en «As local DICOM image» (Como imagen DICOM local). Se abrirá 
el cuadro de diálogo Windows File 
Save (Guardar archivo de Windows) 
estándar. Busque o haga clic en la 
carpeta o directorio deseado, 
introduzca el nombre del archivo y 
haga clic en Save (Guardar). 

 

PACS Store and PACS Print (Almacenamiento en SACI e 
impresión en SACI) 

El software Vision permite 
el almacenamiento en SACI 
(DICOM) y la impresión en 
SACI (DICOM). Estas 
opciones están disponibles 
en todo el software. Por 
ejemplo, si se selecciona el 
botón PACS Store 
(Almacenamiento en 
SACI), se podrá mostrar la 
siguiente ventana de 
diálogo de conexiones de 
red DICOM. Este cuadro de 
diálogo permite al usuario 
realizar un DICOM Store 
(Almacenamiento en 
DICOM), una DICOM Print 
(Impresión en DICOM) o 
Add (Agregar), Modify (Modificar) o Remove DICOM Network connections (Eliminar conexiones 
de red en DICOM) o Peripherals (Periféricos). 

 6.7.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.7.4 
Cuadro de diálogo Save current 
image (Guardar imagen actual) 
 
 
 
 
 
 
 
 
 
Figura 6.7.5 
Cuadro de diálogo DICOM 
Networking (Conexiones  
de red DICOM) 
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PACS DICOM Store (Almacenamiento en DICOM como SACI) 
El software Vision es compatible con el servicio DICOM 3.0 C-STORE. Esto permite enviar una 
imagen o una serie de imágenes (bajo un procedimiento específico) a un sistema de 
almacenamiento remoto compatible con la entidad de aplicación DICOM (AE), como, por 
ejemplo, SACI. Una vez más, la capacidad DICOM Store (Almacenamiento en DICOM) está 
prevista en todo el software Vision. Las modificaciones de Presentation (Presentación) y 
Processing (Procesamiento) se pueden realizar a través de DICOM Modality Setup 
(Configuración de la modalidad DICOM) bajo el menú Tools (Herramientas).  

 Nota: En DICOM Store (Almacenar en DICOM), «SET FILM Attributes» (Ajustar atributos 
de la película) se muestran en gris. 
El usuario puede añadir una nueva configuración para una entidad de aplicación (AE) de 
DICOM remota a la que enviar la imagen o seleccionar una ya configurada, que se muestra en 
las conexiones DICOM Network (Red de DICOM) en el cuadro de diálogo DICOM Networking 
(Conexiones de red de DICOM). Haciendo doble clic (o un solo clic y presionando botón 
Connect [Conectar]) en el icono de la entidad de aplicación (AE) de DICOM remota, el software 
Vision se conectará y establecerá una asociación DICOM con la AE remota seleccionada. Una 
vez que la asociación se haya establecido con éxito, la imagen se podrá enviar para su 
almacenamiento pulsando el botón Store (Almacenar). Después de seleccionar el botón Store 
(Almacenar), el software Vision enviará la imagen seleccionada a la AE de DICOM remota 
definida. Si la operación de almacenamiento tiene éxito, la AE de DICOM remota enviará una 
confirmación de recepción y almacenamiento de las imágenes. Si la operación falla, la AE de 
DICOM remota enviará un código de error indicando la razón del fallo. 
Una sola imagen también puede ser enviada para su almacenamiento haciendo clic en el botón 
derecho del ratón sobre la imagen en «miniatura» mientras está en el navegador de la base de 
datos y siguiendo el mismo procedimiento descrito anteriormente. Es posible enviar una Series 
(Procedure) (Serie [Procedimiento]) completa de imágenes para su almacenamiento. Esto se 
logra haciendo clic en el botón derecho del ratón en el nombre de la Series (Procedure) (Serie 
[Procedimiento]), que aparece en la pantalla del navegador de la base de datos y de nuevo, 
siguiendo el mismo protocolo descrito anteriormente. 
 

Add Session (Agregar sesión) 
El botón Add Session (Agregar sesión) abre el cuadro de diálogo Session (Sesión) a través del 
cual el usuario puede configurar una nueva conexión a una entidad de aplicación DICOM remota.  
Para crear una nueva configuración de conexión a una AE de DICOM remota, el usuario deberá 
tener disponible la siguiente información: Application Entity Title (AE Title) (Título de la entidad 
de aplicación [título AE]), la elección de «function to perform» (Función que se va a realizar) de 
DICOM/SACI, IP Address (dirección IP) y Port Number for the Sever (Número de puerto para 
el servidor [es decir, la impresora DICOM o el sistema SACI]).  
El título AE y el número de puerto del sistema del usuario (es decir, el cliente) también son 
obligatorios. Para crear una nueva configuración, rellene los campos de datos pertinentes y 
seleccione OK (Aceptar). 

 

Selección del comportamiento de la función de sesión 
predeterminada de DICOM/SACI 

Actualmente existen cuatro (4) tipos de 
funciones que una sesión DICOM puede 
representar por defecto. Estos se encuentran en 
la lista desplegable Function (Función) (cuadro 
combinado) que se muestra en la Figura 6.7.6 
siguiente. También hay una lista a continuación: 

1. Una conexión DICOM/SACI GENERAL 

2. Una conexión ALMACENAMIENTO EN 
DICOM 

3. Conexión de una IMPRESORA DICOM 

4. Una conexión LISTA DE TRABAJO de 
modalidad DICOM 

 

 6.7.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.7.6 
Cuadro de diálogo Session 
Properties (Propiedades  
de la sesión) 
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El propósito de la «función» DICOM es permitir la creación de una sesión o conexión 
(añadida) que permita que un «dispositivo» DICOM/SACI solamente pueda ser utilizado, tal 
y como el usuario lo ha configurado, para una categoría de función en particular. Una vez 
configurado, al visualizar o utilizar «DICOM Networking Dialog» (cuadro de diálogo 
Conexiones de red de DICOM) (véase Figura 6.7.5), solamente estará «activo e iluminado» 
el icono correspondiente a la función elegida. Es decir, tendrá un color azul en lugar de un 
color «grisáceo». Por ejemplo, en la Figura 6.7.5 hay tres (3) iconos que representan, en 
orden: un almacenamiento en DICOM (DICOM Store 1), una impresión en SACI (DICOM 
Print 1) y una lista de trabajo de modalidad (DICOM-MWL). Debido a que el icono DICOM 
Store (Almacenamiento en DICOM) fue elegido previamente, es el único que está activo 
(pantalla azul). Asimismo, funciona igual para los otros modos. 
  
 

Modify Session (Modificar sesión) 
El botón Modify Session (Modificar sesión) abre el cuadro de diálogo para la entidad de 
aplicación (AE) de DICOM seleccionada. En esta ventana, el usuario puede modificar la 
información del servidor y del cliente descrita en la descripción de Add Session (Agregar 
sesión). 

 

Remove Session (Eliminar sesión) 
El botón Remove Session (Eliminar sesión) elimina la configuración de la entidad de 
aplicación (AE) de DICOM seleccionada en el software Vision. Una vez eliminada, la 
configuración de la entidad de aplicación (AE) de DICOM no se podrá restaurar, a menos 
que el usuario vuelva a introducir manualmente los datos necesarios mediante el botón Add 
Session (Agregar sesión). Se solicitará una confirmación de la acción; véase más adelante. 
 
 
 
 
 

 6.7.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.7.7 
Verificación de la eliminación 
de una conexión de red 
DICOM existente  
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Association (Asociación) 
 
El botón Association List (Lista de Asociaciones) abre el cuadro de diálogo Association 
(Asociación), representado abajo, mediante el cual el usuario puede editar los parámetros y 
protocolos utilizados por el software Vision cuando negocia una conexión con una entidad de 
aplicación (AE) de DICOM remota. Estas opciones solamente deben ser modificadas por un 
usuario avanzado que esté familiarizado con los protocolos de asociación de DICOM. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Film Attributes (Atributos de la película) 
 
Al seleccionar «Set DICOM Print Film Attributes» (Ajustar atributos de la película de la 
impresora DICOM) en el menú «Command» (Comando) (Figura 6.7.9), aparecerá el cuadro de 
diálogo DICOM Printer Setup (Configuración de la impresora DICOM). Véase la Figura 6.7.10. 
En este cuadro de diálogo, el usuario podrá seleccionar varias opciones que rigen el formato 
de la película y la impresión. Al seleccionar Default (Predeterminado), se restauran todas las 
opciones predeterminadas. Las configuraciones de los ajustes se proporcionan a través de 
menús desplegables. Para aceptar la configuración modificada, seleccione OK (Aceptar). Para 
rechazar las opciones y salir de la ventana sin realizar ninguna modificación, seleccione Cancel 
(Cancelar).  
 
 
 
 
 
 

 6.7.0 Cont. 
 
 
 
 
 
Figura 6.7.8 
Ventana DICOM Association 
(Asociación DICOM) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.7.9 
Establecer los atributos de la 
película de la impresora DICOM 
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PACS Print (Impresión en SACI) 
 
La opción PACS Print (Impresión en SACI) envía la imagen seleccionada a la impresora SACI 
DICOM seleccionada. La imagen se imprimirá de acuerdo con las opciones de formato de 
película y de impresión que se encuentran en el cuadro de diálogo Set Film Attributes 
(Establecer atributos de película) descrito anteriormente. Si el usuario inicia la impresión en 
SACI desde Image View (Vista de imagen), el nivel de la ventana será elegido desde la vista 
de imagen. Si la impresión en SACI se inicia desde el diálogo de base de datos, el nivel de 
ventana será el nivel de ventana por defecto calculado por el software Vision. 
 
 

Close (Cerrar) 
 
El botón Close (Cerrar) cierra el cuadro de diálogo DICOM Networking (Conexiones de red de 
DICOM) y devuelve al usuario al área desde la que se ejecutó el comando DICOM. Este 
comando también cerrará la conexión o asociación entre el software Vision y el dispositivo 
DICOM remoto si se ha establecido una conexión. 
 

 6.7.0 Cont. 
 
Figura 6.7.10 
Cuadro de diálogo DICOM  
Printer Setup (Configuración 
de la impresora DICOM) 
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Descripción general 
 
Las anotaciones de usuario dentro del software Vision permiten aplicar a una imagen una 
«sobreimpresión» gráfica transparente, comúnmente llamada «anotaciones». Estas 
anotaciones adoptan la forma de texto, líneas, líneas de «forma libre» (curvas de Bezier), 
flechas, elipses y cuadros. Esto permite añadir información adicional y «marcadores» a la 
imagen, si se desea. Tenga en cuenta que todas las anotaciones se pueden activar o desactivar 
fácilmente; en otras palabras, se pueden mostrar u ocultar a voluntad. 
 

Funcionamiento 
 
Para comenzar a anotar, seleccione la herramienta Annotations (Anotaciones) del menú de la 
izquierda. Véanse las Figuras 6.4.1 y 6.8.1. Al abrir este cuadro de diálogo, el software pondrá 
inmediatamente al usuario en modo de diseño. También mostrará una «Tool Pallet» 
(Paleta de herramientas). Véase la Figura 6.8.2 siguiente.  

 

 

Al seleccionar Save (Guardar) o Cancel (Cancelar) en este cuadro de diálogo, se cancelarán 
las anotaciones anteriores o se guardarán las anotaciones actuales en la ventana. También le 
devolverá a usted al modo normal de obtención de imágenes. 

La paleta de herramientas consta de quince (15) opciones de herramientas que se muestran a 
continuación. Sin embargo, las herramientas pueden ser truncadas en función de las 
necesidades del usuario a las 8 herramientas más comunes, que se muestran en la fila superior 
del cuadro de diálogo.  

Tenga en cuenta que el comportamiento de la mayoría de estas opciones de herramientas 
implica utilizar el ratón para guiar la posición y la forma dinámica en pantalla. Los «clics» del 
ratón se utilizan para establecer la posición y la forma definitivas.  

El término «swipe» (deslizar) implica mantener pulsado el botón izquierdo del ratón y mover el 
objeto por la pantalla. Si se suelta el botón izquierdo del ratón o se hace clic con el botón 
derecho del ratón, la anotación se colocará en una posición «permanente» o definitiva. 

 

 
 
A partir de la parte superior izquierda de la figura anterior, se mostrará una descripción de cada 
opción de herramienta. 
 
 

  6.8.0 
Anotaciones del 
usuario 
 
 
 
 
 
 
 
 
Figura 6.8.1 
Diseño de anotaciones de usuario 
Paleta de herramientas 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 6.8.2 
Diseño de anotaciones de usuario 
Paleta de herramientas 

 
 
 



 
 

MANUAL DE USUARIO DE FAXITRON CORE | HOLOGIC | REVISIÓN 001 
 

SECCIÓN 
Software 
Vision 6 

6 - 41 

Faxitron® Core 
Sistema de radiografía de muestras 
 

1. Herramienta Selection (Selección): se utiliza para seleccionar (resaltar) un objeto de la 
anotación actual. Haga clic y mantenga pulsado el botón izquierdo del ratón, que establece 
una posición inicial y, a continuación, mueva el ratón. Cualesquiera que sean las 
anotaciones que se encuentren dentro del cuadro que se está mostrando, serán 
seleccionadas para utilizarlas posteriormente. Para finalizar la operación, suerte el botón 
izquierdo del ratón. 

 
2. Herramienta Line (Línea): dibuja una línea recta con esta opción. El comportamiento del 

ratón es el mismo que el de arriba. 
 
3. Herramienta Box (Cuadro): dibuja un cuadro. El comportamiento del ratón es el mismo 

que el de arriba. 
 
4. Herramienta Ellipse (and Circle) (Elipse [y círculo]): dibuja una elipse o un círculo.  

El comportamiento del ratón es el mismo que el de arriba.  
 
5. Herramienta Arrow (Flecha): dibuja una línea con una flecha al final. El comportamiento 

del ratón es el mismo que el de la herramienta Line (Línea). 
 
6. Herramienta Polygon Open Line (Línea abierta poligonal): dibuja líneas no rectas 

«segmentadas y abiertas». Haga clic con el botón izquierdo del ratón, mantenga pulsado 
el botón y dibújelo. Para fijar un segmento de línea, suelte el botón izquierdo. Repítalo 
cuantas veces lo desee. Haga clic con el botón derecho del ratón y la operación de la 
herramienta habrá finalizado. 

 
7. Herramienta Text (Texto): crea un «cuadro de texto» donde se pueden escribir datos 

basados en texto. 
 
8. Herramienta Ruler (Regla): crea un segmento de líneas paralelas. Muy parecida a la 

función Image Tools Ruler (Regla de herramientas de imagen). 
 
9. Herramienta Polygon Closed Line (Línea cerrada poligonal): dibuja líneas no rectas 

«segmentadas y cerradas». Haga clic con el botón izquierdo del ratón, mantenga pulsado 
el botón y dibújelo. Para fijar un segmento de línea, suelte el botón izquierdo. Repítalo 
cuantas veces lo desee. Haga clic con el botón derecho del ratón y la operación de la 
herramienta habrá finalizado. 

 
10. Herramienta Curved Open Line (Línea curva abierta): dibuja líneas curvas «abiertas y 

segmentadas» (curvas de Bezier). Haga clic con el botón izquierdo del ratón, mantenga 
pulsado el botón y dibújelo. Para fijar un segmento de línea curva, suelte el botón izquierdo. 
Repítalo cuantas veces lo desee. Haga clic con el botón derecho del ratón y la operación 
de la herramienta habrá finalizado. 

 
11. Herramienta Curved Closed Line (Línea curva cerrada): dibuja líneas curvas 

«segmentadas y cerradas» (curvas de Bezier). Haga clic con el botón izquierdo del ratón, 
mantenga pulsado el botón y dibújelo. Para fijar un segmento de línea curva, suelte el 
botón izquierdo. Repítalo cuantas veces lo desee. Haga clic con el botón derecho del ratón 
y la operación de la herramienta habrá finalizado.  

 
12. Herramienta Text «Balloon» (Globo de texto): crea un cuadro de texto con un segmento 

de línea que sobresale de una esquina del cuadro de texto. Esto se puede utilizar para 
«enlazar» texto a algo que esté en la imagen que usted haya obtenido. 

 
13. Segmented Ruler (Regla segmentada): dibuja líneas no rectas paralelas «abiertas y 

segmentadas». Haga clic con el botón izquierdo del ratón, mantenga pulsado el botón y 
dibújelo. Para establecer un segmento de líneas paralelas, suelte el botón izquierdo. 
Repítalo cuantas veces lo desee. Haga clic con el botón derecho del ratón y la operación 
de la herramienta habrá finalizado. La longitud de todos los segmentos de líneas paralelas 
se muestra al final de la regla. Útil para una estimación aproximada de la periferia de un 
objeto o paciente. 

 
14. Herramienta Protractor (Escuadra): dibuja un ángulo en la pantalla y proporciona el 

grado del ángulo. Igual que una escuadra. 
 
15. Herramienta Orthogonal Ruler (Regla ortogonal): proporciona dos (2) líneas 

perpendiculares entre sí. 

 6.8.0 Cont. 
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Design Mode (Modo de diseño) y menú contextual del ratón 
 
En el modo de diseño de anotaciones de usuario, pero no en un modo de operación específico, 
se puede hacer clic con el botón derecho del ratón y obtener un menú contextual. Véase más 
abajo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Desde estos menús contextuales se pueden realizar muchas configuraciones específicas. 
 

 Nota: Si un elemento parece demasiado pequeño para leerlo o verlo correctamente, usted 
lo podrá cambiar desde los menús contextuales del ratón mostrados más arriba. De forma 
alternativa, podrá elegir hacer zoom en la imagen utilizando la herramienta Dynamic Zoom 
(Zoom dinámico). Esto ampliará la imagen y usted debería poder ver claramente cualquier 
anotación. 
 
 
 

Mostrar u ocultar las anotaciones 
 
El botón Toggle Annotations (Alternar anotaciones), que se muestra en la  
Figura 6.8.4, permite a los usuarios activar y desactivar rápidamente las 
anotaciones. Por defecto, las anotaciones estarán activadas. El botón se encuentra 
en el menú del lado derecho, cerca de la esquina superior derecha. 
 
 

 6.8.0 Cont. 
 
 
 
 
Figura 6.8.3 
Haga clic con el botón derecho 
del ratón en el menú contextual 
(solamente durante el modo de 
diseño de las anotaciones de 
usuario) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figura 6.8.4 
Opción Mostrar/Ocultar para 
las anotaciones del usuario 
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El menú «Help» (Ayuda), véase la Figura 6.9.1, se encuentra en la barra de menú superior y 
permite un acceso rápido a «User’s Manual» (Manual del usuario) y a «About Vision» (Acerca 
de Vision) de Faxitron Core. Consulte la Figura 6.10.1. 
 
 
 
 
 
 
 
 
 
 
 
 

 6.9.0 
Ayuda 
 
 
Figura 6.9.1 
Menú Help (Ayuda) 
 

 
El submenú «About Vision» (Acerca de Vision) abre un cuadro de diálogo que muestra la 
versión del software de Vision, la fecha, la propiedad intelectual y la información del sistema. 

 

  
6.10.0 
Acerca del 
software Vision 
 
Figura 6.10.1 
Cuadro de diálogo con 
información acerca de Vision 
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